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实践培训内容/画面构成

序号 标题 编号 内容 部件 标签 页号 示例

1.1 图表及仪表显示 图表显示 5 Base(10)

1.2 消息显示 消息显示 17

1.3 数字显示 数字显示 24

1.4 当前时间显示 时间显示 30

1 图表画面/
消息显示

1.5 趋势图显示 趋势图显示 33 Base(11)

2 窗口画面 2.1 窗口显示指南 U-tag 40 Base(20)

3.1 报警概要 Q-tag 51 Base(30)

3.2 报警操作 Q-tag 68

3.3 子显示 X/U-tag 74
3 报警画面

3.4 CF卡存储设置 106

4.1 多语言切换 113
4 多语言在

线切换 4.2 多语言文本索引表 115

5 数据记录 5.1 显示记录数据 数据记录 122 Base (50)

6 配方功能 6.1 配方设置 配方功能 146 Base (60)

7.1 D-脚本编程 165
7

D-脚本

编程 7.2 密码画面制作 183 Base (70)

8 扩展串口
应用

8.1 扩展串口的应用 191
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第一章 图表画面/消息显示

• 图表及仪表显示

• 消息显示

• 数字显示

• 当前时间显示

• 趋势图显示



实践操作教材

5

什么是运行状态画面？

在运行状态画面上可以显示整个设备的数据状态或变化。以下对当前时间

显示、数值（如产量）显示和模拟数据（如功率或速度）的图表显示进行了说
明。

它能够做什么？

运行状态画面

显示产品名称和批号。

查看GP内部的时钟数据，显示当前

时间。

以数值形式显示每条生产线的产量。

以柱状图显示每条生产线的功率值
和速度数据。

4 1

2

3

1

2

4

3
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1.1

图表及仪表显示

本节将说明如何使用图表显示PLC数据。
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可以在GP上显示的图表。

可以在GP上显示的图表包括柱状图、饼图、半饼图、仪表图、趋势图等。

您只需对部件进行简单的设置和放置即可对带有标尺的图表进行应用。标尺会被
自动分成10等份，然后进行放置，可以对标尺刻度进行增减。

显示示例

・从部件工具栏中选择图表

1

柱状图:PLC的字地址数据在柱状图中显示。

饼图: PLC的字地址数据在饼图中显示。

半饼图:PLC的字地址在半饼图中显示。

槽状图:PLC的字地址在槽状图中显示。

仪表图:PLC的字地址在仪表图中的显示。

趋势图:PLC的字地址在趋势图中的显示。

1
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如何显示速度(柱状图设置)

为了监控速度或功率等模拟数据的状态，经常需要使用仪表或图表显示。

・部件工具栏

・菜单栏

从菜单栏的[Parts]中选择[Bar 
Graph]。

或单击柱状图（Bar Graph）图标。

您可以单击[Browser]以选择图表的图片。

[Absolute]
Word Address:设置用于存储

显示数据的字地址。

Data Format:设置存储在字地址中的

数据格式。

Display Mode +/-:如需显示负的数据，

请在此进行设置。(仅在二进制条件下才可以在此处设置)

[Relative]

Bit Length: 为存储于字地址中的数据设置

有效的位长度。

Input Range: 设置存储于字地址中的数

据范围。

Input Code: 如果选择了[No Code]，则仅
处理正的数值。在处理负值时,请选择[+/-
2’s Complement]或[+/-MSB]。

[Absolute]

(1) 如何选择柱状图

(2)一般设置

1

1 2

3

[Relative]

1

1

1

2

3
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要点

关于[Absolute]与[Relative]之间的区别

１００

０

[Absolute]

柱状图增长的显示范围仅在0到100的地址
数据之间。如果数据值大于100，柱状图的

增长就达到最大并且不再变化。

例如：当数据值是80时，图表的增长如右

图所示。

[Relative]

可以为柱状图显示范围的最大/最小值

设置一个可选的数值。

例如：输入范围：最小值[0]到最大值
[4095]。当数据值是1000 时，图表增

长为：

1000
4095 

(小数位被省去)

X 100%=24%

１００％

０ ０％

输入范围

６５５３５

４０９５

Display Direction: 选择图表的显示方向。

Axis Divisions: 只有选择了带标尺的图形时，

才能对其进行设置。如不需要标尺，请

设置为[0]。

(3) 图表设置

１０００→

←２４％

1
1
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您可以单击[Browser]以选择图表的

图片。

为图表设置颜色。

Alarm Display:如果显示的数据在已设置的报

警范围内，它就可以按照数值以不同的颜色显
示。

Alarm Type: 如果设置了[Direct]，报警范围的
最大值和最小值不变。如果设置了[Indirect]，
报警范围的最大值和最小值可变。

Alarm Range: 设置报警值的范围。

*报警范围内值的单位是百分比。
输入范围是最小值[Min.Value]为0到99和最大值
[Max.Value] 为1到100 。

Alarm Color:设置触发报警时的显示颜色。

(4) 外观/颜色设置

(5) 报警设置

1 2

1

1

2

1
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放置柱状图

以下将说明对显示每条生产线速度的
柱状图进行设置的方法。

[设置流程]

1.打开基本画面 [B10]
2.设置并放置柱状图

在部件工具栏中单击柱状图
[Bar Graph]图标。

单击[Browser]并且按照您的需要选择

柱状图的图形。

选中[Absolute]并将字地址设置为
D55，数据格式[Data Format]为二进
制[Bin]。

将显示方向[Display Direction]设置为
向右[Right]。

1

1 2

1

(1) 选择柱状图

(2) 一般设置

(3) 图表设置

1

1

2
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单击[Place]将柱状图放置在

画面上。

设置显示生产线B-D速度的柱

状图。

生产线B-D的速度数据存储地

址如下：

生产线B: 字地址 [D56]
生产线C: 字地址 [D57]
生产线D: 字地址 [D58]

1

1

(4) 放置图表

(5)设置并放置其它图表

1

1
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如何显示功率 (仪表图设置)

・为监控速度或功率等模拟数据，经常需要使用仪表图。

在菜单的[Parts]中选择[Meter]

或单击仪表图(Meter)图标。

您可以单击[Browser]以选择图表的图

形。

[Absolute]

Word Address: 设置用于存储显示

数据的字地址。

Data Format: 设置存储在字地址中

的数据格式。

Display Mode +/-: 当显示负数数据

时请在这里进行设置。(只有在二进制
的情况下才可以在此进行设置)

(1) 如何选择仪表图

(2) 一般设置

・部件工具栏

・菜单栏

1

1 2

[Absolute]

1

1

2
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[Relative]

Bit Length: 设置字地址中存储数据的

有效位长。

Input Range: 设置存储于字地址中的

数据范围。

Input Code: 如果选择了[No Code]，

则只会处理正的数值。在处理负数
时，请选择[+/- 2’s Complement]或选
择[+/- MSB]。

*关于[Absolute]和[Relative]之间的区
别，请参考第7页要点。

[Relative]
3

3
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Display Direction: 选择图表的显示方向。

Axis Divisions: 只有选择了带有标尺的图

形后才能对其进行设置。如果不需要标尺，
请将其设置为 [0]。

您可以单击[Browser]以选择图表的图片。

为图表设置颜色。

Alarm Display:如果显示的数据在已设置的

报警范围内，它就可以按照数值以不同的颜
色显示。

Alarm Type:如果设置了[Direct]，报警范围

的最大值和最小值不变。如果设置了
[Indirect]，报警范围的最大值和最小值可变。

Alarm Range:设置报警值的范围。

*报警范围内值的单位是百分比。
输入范围是最小值[Min.Value]为0到99和最

大值[Max.Value]为1到100 。

Alarm Color:设置触发报警时的显示颜色。

(3) 图表设置

(4) 外观/颜色设置

(5) 报警设置

1

1 2

1

1

1

2

1



实践操作教材

16

放置仪表图

以下将说明对显示每条生产线功率值
的仪表图进行设置的方法。

[设置流程]

1. 打开基本画面 [B10]
2. 设置并放置仪表图

从部件工具栏中单击仪表图(Meter 
Graph)图标。

单击[Browser]并按照您的需要设置

仪表图的图形。

选中[Absolute]选项并将字地址[Word 
Address]设置为D55，数据格式为二
进制[Bin]。

将显示方向设置为顺时针方向
[Clockwise]。

1

1 2

1

(1) 选择仪表图

(2) 一般设置

(3) 图表设置

1

1

2

1
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单击[Place] 将仪表图放置在画

面上。

设置显示生产线B-D功率的仪表图。
生产线B-D的功率数据存储地址如

下：

生产线B:字地址 [D56]
生产线C:字地址 [D57]
生产线D:字地址 [D58]

1

1

(4) 放置图表

(5) 设置并放置其它图表

1

1
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1.2

本节将说明消息显示功能的用法。

消息显示
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消息显示的方法

两种操作模式:  位模式和字模式。
位模式:  根据所设位地址的ON/OFF状态，切换显示2条不同的消息。
字模式:  根据所设字地址中数值的变化，切换显示最多16条不同的消息。

※如果设为字模式
则使用该字地址的低4位进行消息切换。

・根据所设位地址的状态或字地址中数值的变化来切换显示不同的消息。

最大16条消息

选择使用字地址的位数

Messages Used bit count

2 1
4 2
8 3
16 4

指示灯可以切换2种状态，4状态灯可以切换4种状态，如果超过16种
状态，就需要使用L –Tag (Indirect)

消息显示

提示

・・・

１５ １４ １３ １２ １１ １０ ０９ ０８ ０７ ０６ ０５ ０４ ０３ ０２ ０１ ００
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如何显示消息? (消息显示设置)
・ 通过改变指定位/字地址中的数据，可以最多切换显示16条消息。

从菜单栏的[Parts]中选择
[Message Display]

或单击消息显示(Message Display)
图标。

此处显示当前消息显示部件的图形。
单击[Browser]，可以选择消息显示部

件的图形。

设置更改消息的地址。当[Mode]是[Bit]
时，设置位地址；而当[Mode]为[Word]
时，则设置字地址。

设置消息显示框的颜色

如果有两条消息，则设置成[Bit]，如果是3-16条，则将其设置成[Word]。

(1) 如何选择消息显示部件?

(2) 一般设置

Alignment: 可以选择的消息对齐方式包括左对齐/居中/右对齐。

Font Size: 设置消息的字体大小。

・部件工具栏

・菜单栏

1

1 2

3

4

5

1

1

2

3

4

5
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操作模式：位（Bit）

操作模式：字（Word）

设置每条消息的[Style]、[Text Color]和
[Plate Color]。

(3) 消息设置

Direct: 直接输入要显示的字符。

Browse Text Table:

选择文本索引表中记录的字符串。(用于
画面文字的多语言切换)

No. Of Messages: 设置要转换和显示的消息

数量。可选的消息数量包括‘‘2’’,‘‘4’’,‘‘8’’,‘‘16’’。
Display Characters: 设置显示文本的字符数。

最大字符数是40个单字节字符。

Message : 按钮仅显示“消息数”中设置的数量。

选择数量并输入相关消息。

Display Characters: 设置显示消息的字符数。
最大为40个单字节字符。

Selected Message: 在此处输入显示消息。

Message: 选择指定位ON/OFF的按钮，来输

入相关的显示消息。

Copy from Description: 将[General 
Settings]的[Description]中设置的文字复制到
[Selected Message]。
Copy to All :将当前[Selected Message]中输
入的文字复制到所有的[Selected Message]。

1

3

4

2

1

2

3

4
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［设置流程］

1.打开基本画面 B10
2. 设置/放置消息显示部件

如何显示生产线运转状态的
消息。

如何放置消息显示部件

从部件工具栏中单击消息显示
部件(Message Display)。

单击[Browser]并选择需要的图形。

将 [Mode]设置成 [Word]，将[Address]
设置成 ‘‘D68’’。
设置需要的 [Border Color]、
[Alignment]和[Character Size]。

1

1 2

(1) 如何选择消息显示部件

(2)一般设置

1

1

2
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选择[Direct]并将 [No. of Messages]设置
成 ‘‘8’’，[Display Characters]为 ‘‘14’’。
[Message]选择 ‘‘0’’。

在选定消息[Selected Message]中输入
‘‘正常’’[Normal]，并设置所需要的字符样

式和颜色。
顺序更改从1到4的消息设置，分别记录

以下消息：
消息设置：1.为 “电力异常”
消息设置：2.为 “生产线堵塞”
消息设置：3.为 “调整中”
消息设置：4.为 “异常停止”

单击[Place]并将[Message Display]放
置在画面上。

实际操作流程如下：

※ 与4状态灯一样，可使用工具栏转换部件状态来切换显示。

1 2

1

在字地址中存储 ’‘0‘’ 在字地址中存储‘‘1’’ 在字地址中存储‘‘2’‘ 在字地址中存储‘‘3’’ 在字地址中存储 ‘‘4’’

(3) 消息设置

(4) 放置消息显示部件

(5) 操作消息显示部件

1

2

1
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对状态灯或消息显示的图形对齐方式进行修改- 对齐

例如，如果部件图形发生了变化，如右图所示 …

单击整个部件以指定。
(在周围区域显示操作方法)

然后单击显示的转换标签，并且仅选择标签部件。

右键单击此标签，转到下拉菜单项目
中的对齐方式[Alignment]选项，最后
单击居中[Center]。

标签就被放置在此框的中心。

※也可以选择居中以外的对齐方式。
※也可以在[Switch]或[Numeric Display]部分中使用。
※如果使用了’Align’ ‘Others’，可以在指定的范围内选择多个对

象，并且可以将其在X轴和Y轴排列。

①

②

③

④

⑤

提示

示例
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1.3

本节将说明如何以数值形
式在GP上显示PLC数据。

数字显示



实践操作教材

26

如何显示产量（数字显示设置）

・为在运行状态画面上显示产量，我们使用了数字显示功能。
使用数字显示功能能够使您方便地在画面上显示数据消息。

从菜单栏的[Parts]菜单中选择
[Numeric Display]。

或单击数字显示(Numeric Display)图标。

这时会显示当前选定的图形。单击
[Browser]可以选择其他的显示图形。

设置用于保存显示数据的[Word Address]。

(1) 选择数字显示部件

(2) 一般设置

1

1 2

1

1

2
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设置显示的格式。在32位的条件下，会使

用指定地址和相邻地址连续两个地址。

Code +/-: 如要显示负的数据，请在此处
选择。只有在数据格式为[Dec]时才可以

使用。

No. of Display Digits: 设置显示数据的

位数。

Decimal Places: 设置小数位的位数。

Character Size: 设置字符大小。

Shift Right: 右对齐显示。

Shift Left: 左对齐显示。

Zero Suppress: 确定是否不显示0。

例如：选中时显示 123
未选中则显示 00123

Zero Display: 确定当数据为0时是否显示0。

例如：选中时显示0
未选中则显示 (无显示)

7 Segment Display: 以7段数码管的形式显示。

这时会显示当前所选的显示图形。单击
[Browser]能够选择其他的显示图形。

为显示的图形设置颜色。
*为[Numeric Color]和[Plate Color]分别

设置不同的颜色。如果这两种颜色相
同，则无法看到数字显示。

(3)显示格式设置

(4) 外观/颜色设置

1 2

3

1 2

1

1

3

2

2
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如果您在报警设置中选择了[Direct]，则触发报警的最大/最小值是固定的。
如果您选择了[Indirect]，这时就会自动顺序分配连续字地址，分配顺序为：

指定地址－最大值存储地址－最小值存储地址。

例如：报警类型：如果选择了[Direct]

报警范围最小值：40
最大值：1000

如果数据小于40或大于1000，就会出现报警。

报警类型：如果选择了[Indirect]

报警范围最小值：字地址+2
最大值：字地址+1

如果数据小于最小值或大于最大值，就会出现报警。

要点

Alarm Display: 如果显示的数据在已设置报

警的范围内，它就会以不同的颜色显示出来。

Direct: 最大/最小报警值范围不变。

Indirect: 最大/最小报警值范围可变。

保存最大/最小报警值的地址为指定地址后连
续的两个地址。

设置报警值范围。

设置触发报警时的显示颜色。

(5)报警设置

1 2

3

2

3

1



实践操作教材

29

放置数字显示部件

现在我们使用数字显示部件显示产量。

以下将说明对显示每条生产线产量的
数值显示部件的设置方法。

[设置流程]

在部件工具栏中单击数字显示
（Numeric Display）图标。

单击[Browser]并按照您的要求设置显示

部件的图形。

在 [Word Address]中设置 [D50]。

1. 打开底部基本画面 [B10]
↓

2. 设置并放置数字显示部件

1

1 2

(1)设置流程

(2) 选择数字显示部件

(3) 一般设置

2

3

1
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将“数字显示”放置在生产线B-C和次品位

置旁。
“数字显示”中字地址按如下设置:

生产线B: 字地址 [D51]
生产线C: 字地址 [D52]
次 品:   字地址 [D53]

将[Date Display Format]设置为
[16bit Decimal]。

将[No. of Display Digits]设置为[5]，
[Decimal Places]设置为[0]，[Character 
Size]设置为[2x1(f)]。

设置您喜欢的[Display Style]。

・您可用复制功能来复制组中的多个对象。
如果是可以设置地址的部件，如位开关/字开关，地址会自动累加。
(*从菜单栏的[Edit]中选择复制[Duplicate]功能。)

1 2

3

1

要点

(4) 打开显示格式设置

(5)放置数字显示部件

2

3

1

1
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本节将说明如何在GP上显示当前时间。

1.4
当前时间显示
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如何显示当前时间 (时间显示设置)

・为在GP上显示当前时间，需要使用时间显示部件。时间显示部件会根据GP
中的系统数据区域内设置的时钟数据来显示时间 (通过时钟功能计时)。

从菜单栏的[Parts]中选择[Time Display]。

或单击时间显示(Time Display)图标。

这时会显示出当前所选显示部件的图形。
您可以单击[Browser]以选择其它显示部

件的图形。

Character Size: 设置时间字符的大小。

Seconds Display: 不但可以显示小时/分钟，还可

以显示秒钟。

7Segment Display: 以7段数码管的形式显示。

设置显示图形的颜色。
为[Text Color]和[Plate Color]分别设

置不同的颜色。如果这两种颜色的设置相同，则无
法看到数字显示。

在常温和非电气环境下，时钟数据的误差为±65秒/月。但是根据使用年限或外
部温度的不同，误差可能会达到[–380~+90秒/月]。如果系统需要精确的时间，

请定期进行时间修正。

要点

(1) 选择时间显示部件

(2)设置时间显示部件

・部件工具栏

・菜单栏

1

2

3

1

1

1

2

3
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放置时间显示部件

以下说明设置时间显示部件的方法，
此显示部件用于显示当前时间。

[设置流程]

1. 打开基本画面B10
2. 设置并放置时间显示部件

单击工具栏中的时间显示（Time Display）图标。

根据您的需要对字符大小[Character 
Size]和颜色进行设置。
*时间显示部件的地址不能设置。

完成全部设置后，请单击[Place]以将时间

显示部件放置到画面上。

1

1

1

(1) 选择时间显示部件

(2) 设置时间显示部件

(3) 放置时间显示部件

1

1

1
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本节将说明如何在趋势图中显示PLC 数据。

1.5
趋势图显示
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如何显示趋势图

・为了及时监控数据的变化，可以选择使用趋势图。它适用于对发生变化的数据
进行长期观察。

*在示例画面中未使用此功能。

从菜单栏的[Parts]中选择
[Trend Graph]。

或单击趋势图(Trend Graph)图标。

您可以单击[Browser]选择图形。

Display Mode +/-:如果要显示负数，请在

此进行设置。（只有在二进制的条件下才
能在此进行设置）

Data Format: 

设置存储在字地址中的数据格式。

(1) 如何选择趋势图

(2) 一般设置

・菜单栏

1 2

・部件工具栏
1

1

1

2
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设置曲线类型。
*如需更多信息，请参见下一页。

Display Direction: 设置趋势图的显示方向。

Data Samples: 设置趋势图中显示数据的数量。

Scroll: 设置趋势图显示区域用完后需要滚动显

示数据的数量。

Sampling Time: 设置读取数据的周期，以秒

为单位。

Backup: 当您选中 [Graph Backup]后，就可以

在关闭电源时保存趋势图数据，并在接通电源
后将其显示出来。当您选中[Synchronous 
Mode]后，曲线就会顺序显示从关闭电源前开

始的数据。如果没有选中，趋势图的数据就会
从[0]重新开始。

Axis Scale: 设置水平方向和垂直方向划分的
等份。如果无需标尺，请将其设置为[0]。

Display Range: 如果选中了标尺，就可以设置趋势图中所显示数据的上限和下

限范围。
*此功能仅对GP2000系列有效，并且曲线显示必须为[Block Display]。

Historical: 可以在趋势图中显示历史记录。设置用于保存的数据数量，并且放

置历史记录显示按钮。
* 此功能仅对GP2000系列有效，并且曲线显示必须为[Normal]和[Pen Recorder]。

(3) 曲线设置

1

2

3

4

1

2

3

4
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・ Normal

每次过了取样期后，就会将最新数据添加到指定的显示方向中。如果曲线
达到了趋势图的极限，曲线就会根据“滚动”（Scroll）中设置的数值左移。

・ Pen Recorder

每次过了取样期后，曲线就会按照指定方向相反的方向显示。最新数据始
终会在趋势图显示区域的极限上显示（在此示例中为右侧）。

・Block Display

在单个趋势图中显示连续字地址中的全部数据。控制曲线显示的ON/OFF，
需要为其创建地址。

开始显示

要点

*控制显示的地址

※

※

※

※

※

※

※

※

※

※

※

※
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No. of Channels: 设置趋势图曲线的数量。
在一个趋势图内最多可以设置20条曲线。
对于ST/GP2000系列，在整个工程文件中
最多可以设置40条曲线。其他系列可设置
20条曲线。

Word Address: 设置显示数据在选定通道

中存储的地址。

可以在通道数量[No. of channels]中选择

数量和通道设置。请选择用于设置的通
道。

设置当前选定通道的显示曲线类型和显示颜
色。

您可以单击[Browser]并选择图形。

为曲线设置颜色。

(4) 通道设置

(5) 外形/颜色设置

1

2 3

1 2

1

2

3

1

2
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Alarm Display:如果显示的数据在已设

置的报警范围内，它就会按照数值以不
同的颜色显示出来。
Current Channel: 您可以在[No. of 
channels]中选择数量和通道设置。选

择用于报警设置的通道。

设置报警范围。

设置报警显示的颜色。

选择要设置的辅助线。

辅助线的设置可以采用图形格式显示，
但是它与实际显示的画面不同。

Draw Line: 如要显示辅助线，请选中
[Line]选项。这时可以设置辅助线的显示

位置、类型和颜色。

Direct:直接设置辅助线的显示位置。显

示位置不变。

Indirect: 将数据存储在设置字地址中并

指定辅助线的显示位置。显示位置会随着
数据的变化而变化。

只有在图形设置为[Block]或[Scale]时，

才能在此进行设置。辅助线可以显示在
图形中。

(6) 报警设置

(7) 辅助线设置

1

2 3

1

2

1

2

3

1

2
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第二章 窗口画面

• 窗口显示指南
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本节将说明创建窗口显示的方法。

2.1
窗口显示指南
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窗口显示方法(窗口注册) 

・需要在基本画面上以窗口形式显示部件。有两种窗口注册的方法，即在
窗口画面(Window Screen)中注册和在基本画面(Base Screen)中注册。

・窗口画面注册的方法

单击新建(New) 图标。

选择窗口画面[Window Screen]并单击[OK]。

在窗口画面中放置部件/Tag/图片等。然

后，关闭此带白色边框的窗口区域。
如果保存了窗口画面，窗口区域中指定
的范围就被注册为窗口。

※当您打开窗口画面时，就会显示出窗
口区域。如果选定了此区域并且进行拖
动，就可以更改其大小。

以下将说明在窗口画面中进行窗口注册的方法。

(1) 如何打开窗口画面

(2) 如何进行窗口注册

1

2

1

2

1
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・基本画面的注册方法

在基本画面中创建将要注册为窗口
的画面。

从菜单栏的[Screen]上选择[Window 
Registration]。

以下将说明在基本画面中进行画面注册的方法。

单击[Add]。

(1)如何打开要进行注册的基本画面

(2)如何进行窗口注册

1

2

1

1

2
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鼠标箭头变成‘+’号。分别单击开始

点和结束点以采用白框选取要注册
为窗口的区域，就像绘制一个矩形
一样。

输入窗口的[Registration No. ]和
[Description]，在单击[OK]后，窗口注

册完成。

注意

・K-Tag， U-Tag, V-Tag, v-Tag, 趋势图, 键区输入显示, 登录显示, CSV 显示, 
文件管理器显示等在窗口中不起作用。

4

3

4
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窗口显示方法(U-Tag设置)
・可以通过调用其它基本画面/窗口画面上的部件/Tag/图形以显示或操作。
如果U-Tag调用了基本画面上的部件/Tag，就需要对所调用的部件/Tag进行

窗口注册。

从菜单栏的[Tags]中选择[U-Tag]。

或单击U -Tag(U-Tag)图标。

如果选中[High Speed]，那么所选窗口中的

速度就会增加。但是，基本画面的整体性能
会降低。同时，[Designated window] 就只
能是[Direct]。

※同一画面中，最多放置2个带有[High Speed]
的U-Tag。

当指定的窗口是[Direct]时，就可以通过1个U-Tag显示一个固定窗口。

并且调用位置也是固定的。

设置控制窗口显示/关闭的地址。
如地址中的值为‘‘1’’，窗口显示。如值为‘‘0’’，窗口关闭。

设置指定窗口。

设置被调用窗口的注册号。

(1) U-Tag的选择方法

(2) 指定窗口(直接)设置

・部件工具栏

・菜单栏

1

1
2

3

4

1

1

2

3

4
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设置控制窗口显示的地址。从设置字地址
的位置开始使用了4个连续的字，并且将其分
别设置为窗口显示/隐藏，要显示的窗口注册

号和窗口的坐标显示位置。
・在[Indirect]条件下的字地址内容。

如果指定窗口设置为 [Indirect]，就可以通过U-Tag显示和转换多个窗口。

并且其显示位置是可变的。

设置保存在字地址中的数据格式。

+ 0 窗口显示控制字

+ 1 要显示窗口的注册号

+ 2 窗口显示位置的 X坐标值

+ 3 窗口显示位置的Y 坐标值

※对于坐标而言，窗口的左上角作为其原点。

(3) 指定窗口 (Indirect) 设置

1
2

1

2
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如何放置U-Tag

如何进行窗口显示。

[设置流程]

1.打开基本画面 B510
2. 在“自动运行”的指导下进行窗口注册
3. 打开基本画面 B20
4.设置/ 放置 U-Tag

打开基本画面B510

单击[Add]。

从菜单栏的[Screen]菜单中选择
[Window Registration]

2

1

(1) 如何打开基本画面

(2) 如何进行窗口注册

1

2

1
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选定窗口注册的范围。

在[Registration No.]中输入‘2’并且在
[Description]中输入[Auto Run]，然后
点击[Ok]。

在Tag工具栏中点击U -Tag(U-Tag)图标。

打开基本画面 B20。

将[Designated Window]设置成
[Direct]， [Window Address]设成
‘D65’，并将[Window Registration No.]
设置成 ‘2’。

4

3

1

1

(3) 如何选择U-Tag

(4) 如何设置 U-Tag

3

4

1

1
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在您单击[OK]后，画面上就会出

现紫色边框。然后将其放置在要
显示窗口的位置。

1

(5)如何放置 U-Tag

1
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• 报警概要

• 报警操作

• 子显示

• CF卡存储设置

第三章 报警画面
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什么是错误状态记录画面？

可以更改显示报警消息的顺序。

可以使用Q-Tag显示的说明。

可以根据报警显示消息概要。另外，如果您选择了某条消息，就会显
示出与其相关的措施。

当发生报警时，可以将报警消息作为历史记录在列表中显示。显示列表中的

报警历史有助于维护系统并降低停机率。

使用子显示功能可以采用图片或指南形式显示每条报警的详细消息和措施。

与报警关联的指导措施可以将损失降到最低，并保证每个人都能够从故障中恢
复。

箱内热度发生错误!

请检查**!!

按照显示的恢复流程，就不
必咨询相关的技术人员。这
样每个人都能够解除故障。

・可能发生什么 ?

・错误状态记录画面

1
2

3

1

2

3
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本节将说明如何以概要形式显示报警。

3.1
报警概要
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如何以概要形式显示报警

为能够以概要形式显示报警，首先需要记录报警监控地址和消息。所记录的消息
将会以Q-Tag的形式显示在画面上(报警概要显示功能)。使用Q-Tag可以显示带有时

间的触发报警消息概要。

使用Q-Tag记录的消息量可以高达768条。(GP2000/77R系列)
当消息量超过了最大数量，就会从最旧消息开始删除消息。

要点！

①在报警编辑器中，记录报警监控位或消息等。

②在画面上放置Q-Tag以显示报警。

③与PLC通信后显示报警消息

设置报警概要的步骤

・如何以概要形式显示报警?
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・报警数据的流程

备份
静态存储器

在 GP内部

1

3

4
CF卡

打印机

2

发生错误!

请检查**!

PLC->SRAM: 当发生错误时，报警数据就会备份在静态存储器（SRAM）中。

SRAM<-->Q-Tag:在画面上对备份在静态存储器中的报警数据进行显示或编辑。

打印输出：将打印机连接到GP并打印出报警数据。

保存到CF卡：在CF卡上保存备份在静态存储器中的报警数据。

1

2

3

4
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或从报警编辑器的图标上选

择一种报警类型

基本报警:不适用于Q-Tag

位报警日志:监控地址是一个位地
址。当位地址状态变为ON时，

显示报警消息。

字报警日志:监控地址是字地址。

当字地址中数值与设定值相同
时，显示报警消息。

如何记录报警消息和地址

・以下将说明如何设置报警消息和报警触发地址。

从菜单栏的[Screen/Setup]中选
择[Alarm]。

或单击报警(Alarm)图标。

从菜单栏的[Alarm]中选择报警类型。

(1) 如何打开报警编辑器

(2)如何选择报警类型

1

1

1

1
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Direct:直接在编辑器上输

入消息，

Browse Text Table:在文

本索引表中记录的文字来
更改消息。

Bit Address: 指定监控的位地址。
Group No.: 可以在LS区域中使用相同的组编号存储触发报警设置的计数。
可以通过[System Setup]中的[Q- tag Setup]对用于存储的LS区域进行设置。

Sub Display: 指定作为子显示的画面编号。

State:当监控地址为ON或OFF时，进行报警已触发的设置。

Message: 输入要显示的报警消息。

记录消息的最大数量(位日志报警+字日志报警)如下:

・GP270, GP-H70, GP370系列 : 512
・GP70, 77R系列（不包括以上）: 768
・GP2000 系列 :2048

要点

(3)报警编辑器(位日志)设置

1

2

1

2
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当使用扩展功能时，就会增加以下功
能。(仅适用于ST系列和GP2000系列)

②
选中[Use Extended Function]后，[Level]就会添加到报警编辑器的项目中。
可以设置从0到7共8级，并且可以为每级设置消息的显示颜色。

Word Address: 设置监控的字地址。

Alarm Values: 设置触发报警的字地址数据值。

Bit: 如果监控为1字，则是[16]；而2字则是[32]。

Data Format: 设置报警值的

数据格式。

１．显示触发报警计数、累计时间、
等级等项目

２．显示项目的分类功能(仅用于活动
的历史记录)
３．为每个等级设置显示颜色

４．块数量扩展到8个
５．获得当前选定报警消息的标识

６．通过外部操作以清除出现时间和
累计时间

７．添加Q-Tag选择键 (T-Tag)的操

作项目

８．Q-Tag的边框类型设置

(4) 报警编辑器(字日志)设置

(5) 使用扩展功能时的设置

2

1

1

2

1

2

1
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使用块功能使您能够控制报
警并将其最多划分为8个块。

选择显示模式

Active: 只显示当前触发的报警，报警恢复消息即被删除。

History: 报警触发/确认/恢复时间显示在同一行。

Log: 报警触发/确认/恢复时间分三行显示。

可以选择块。
选择块1到3并且分别输入消息。
通过使用扩展功能，最多可以选择8个块。

・什么是块功能?
使用块功能可以让您划分块并将消息记录到最多8个块中(需使用扩展功能)
以进行控制。因此，可以按等级划分报警并在GP上显示。

例：在每个画面上显示具有不同等级的报警。

通过等级划分显示消息可以让您立即确定消息的等级。

仅用于重大事故的报警
在 B1上显示

仅用于中等事故的报警
在 B2上显示

仅用于小事故的报警
在B3上显示

(6) 使用块功能时的设置

2

1

3

要点

B1 Big B2 Medium B3 Small

1

2

3
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现在记录报警消息

现在我们通过报警编辑器来记录报
警消息

[设置流程]
1.打开报警编辑器
2.记录监控和消息的地址

单击[Alarm]图标。

单击位日志(Bit Log)图标。

选中[Use Extended Function]。

按照框中的显示设置[Bit 
Address]、[Group No. ]、
[Sub Display]、[State]、
[Level]和[Message]。

在完成全部设置后，请单击保
存[Save]。

1

1 4

2

3

(1) 打开报警编辑器

(2) 记录监控地址、消息和等级等

1

2

3

1

4
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如何显示报警消息

・为在画面上显示在报警编辑器中记录的报警消息，请使用Q-Tag。

或单击Q -Tag(Q -Tag)图标。

从菜单栏的[Tags]中选择[Q -Tag]。

在使用块功能时，请在此处选择显示模式。
Active: 只显示当前触发的报警，报警恢复

消息即被删除。
History: 报警触发/确认/恢复时间显示在同

一行。
Log: 报警触发/确认/恢复时间分三行显示。

注: 在使用块功能时，此设置会更改位块编

号的设置。

可以在报警编辑器中对[Active]、[History]和
[Log]进行设置。

设置报警消息的显示顺序。

请从以下进行选择。

(1) 如何选择Q -Tag(报警概要显示功能) 

(2) 显示模式设置

・菜单栏

・Tag工具栏

1

2

1

1

1

2
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・每种显示模式的显示示例 (当前, 历史,日志)

[Log]: 一个报警的报警触发/确认/恢复时间分三行显示。

例：

[History]: 一个报警的报警触发/确认/恢复时间和报警消息都在同一

行显示。

例：

[Active]: 只显示当前触发的报警消息。

在报警恢复以后，报警消息消失。

例：

要 点
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・使用显示行开始的示例
如果您希望出现多个报警后在每个Q-Tag上显示报警结果而无需滚

动画面，那么请设置显示行开始。

・通过Q-Tag1从1到10行显示报警消息

将 [1]设置用于行开始，而[10]用于显示行的数量。

・通过Q-Tag2从11到20行显示报警消息

将 [11]设置用于行开始，而[10]用于显示行的数量。

・通过Q-Tag3从21到30行显示报警消息

将 [21] 设置用于行开始，而[10]用于显示行的数量。

要 点

B1
Ｑ- tag 1

Messages from 1 
to 10 display

B2
Q- tag 2

Messages from 
11 to 20 display

B3
Q-Tag 3

从 21到 30 的消息

显示
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Common:当多个放置的Q-Tag具有相同显示格
式类型时使用。可以在[System Setup]设置此

格式。

Individually:当多个放置的Q-Tag具有不同显示
格式类型时使用。可以在[Q- Tag Display 
Format]中设置此格式。

此处显示[Q -Tag Settings]。
要获得详细设置消息，请参阅(4)Q –Tag设置]。

分别设置显示格式。
选中要显示的项目并设置从每个项目种显
示的字符。为设置[Multiple]、[Accumulate]
和[Level]，请在报警编辑器中选中[Use 
Extended Function]。

为每个显示模式设置报警存储的数量。
将当前/历史/日志的总数设置为768 或
更少。当使用块功能时，为每个块设
置存储数量。

当显示形式设置为[Normal]时，设
置Q -Tag的显示形式。

设置LS区域的开始地址，从此地址开

始记录带有报警编辑器中所设置组编
号的触发报警的数量。

控制地址中的存储命令使您能够从外部进行 [Ack All]、 [Delete All], [Clear All 
Number*], [Clear All Time*]等操作。
※仅支持 GP2000 系列。只有使用[Extended Function +Block Function]时才能够操作。

Alarm Message Displayed by Q-Tag: 设置当电源装置关闭时，是否对由
Q-Tag显示的报警消息进行备份。
PLC Data Monitored by Q-Tag:设置当GP电源关闭时，是否保留由Q-Tag
监控的PLC数据。

(3) 显示格式设置

(4) Q-Tag设置

1 2

3

1 2

3

4

5

1

1

2

3

2

3

4

5
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从工程管理器的[GP Setup]中的[Extended Settings]中选择[Q-

Tag Settings]，它可以使您打开 [Q- Tag Settings]。

要点

设置在报警触发、确认和恢复时间的字符颜
色和背景颜色。当使用扩展功能时，可以为
每个等级设置报警触发、确认和恢复的颜色。

设置清除报警时的颜色。

可以在此处设置的LS区域内存储当前选定报警

消息的报警编号。
・报警编号

(5) 大小/颜色设置

(6) 扩展功能设置

如果没有选中[Notify ID at each cursor movement]，那么在每次触发[T-Tag]
中的[Q-Tag selection key]的[Alarm information acquisition function]时，就
会将一条报警编号存入LS区域。如果选中了[Notify ID at each cursor 
movement]，每次移动光标时就会将警报编号自动存储到LS区域。

１

2

1

1

2

1
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现在显示报警消息

现在让我们使用Q-Tag来显示报警

概要。

这里说明了如何使用Q-Tag在画面上

显示通过报警编辑器记录的报警消息

从工具栏上单击[Open Screen]图标。

选择B11的[Error State (Log)]。

单击[Open]。

从Tag工具栏中单击Q (Q-Tag)
图标。

2

3

1

(1) 打开Error State [ Log]画面

(2) 选择Q-Tag

1

2

3

1

1
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将显示模式设置为[History]，并且将默
认排序设置为[Order of New Date & 
Time]。

按以下所示设置显示模式。

[No. of Display Char: 66], [Line Start: 
1]

[No. of Display Lines: 8], [Line 
Spacing: 0]

按您的需要设置[Scroll Direction]和
[Border Type]。

选中[Common]。

将日期[Date]设置为[mm/dd]，将时间
[Time]设置为[24:00]。

单击 [System Setup]。
这时将显示下面的[(5) Q-Tag Setting]。

选中Q-Tag显示格式中的所有项目并

按如下所示进行设置。

[Date: 22] [Trigger: 28] [Message:2]
[Ack.: 34] [Recovery: 40] [Multiple: 
46] [Accumulate: 52] [Level: 63]

单击 [OK]。

1

3
2

1 3

2

1 2

(3) 显示模式

(4) 显示格式

(5) Q-Tag设置

1

2

3

1

2

3

1

2
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将显示大小[Display Size]设置为[1x1 (f)]。

对于等级0, 2, 5和7，分别设置您需要的
触发[Trigger]、确认[Ack.]和恢复
[Recovery]的颜色。

单击[OK]。

放置 Q-Tag。

1

2

3

1

(6) 设置大小/颜色

(7) 在画面上放置Q-Tag

1

2

3

1
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如果将显示格式设置为[Common]，那么在将数据传输到GP中时，必须将[GP
System Screen]一同传输。如果没有传输[GP System Screen]，数据就不能在

设置的格式中显示。

注意！

参见以下步骤：

在传输数据时，选择菜单栏
的[Setup]并单击其中的
[Transfer Settings]。

选中[GP System Screen]。

1

2

1

2
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本节将说明如何操作由
Q-Tag显示的报警消息。

3.2
报警操作
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如何操作Q-Tag的报警消息

・可以对Q-Tag显示的报警消息进行操作。
为对其进行操作，请从T -Tag的[Special]中选择[Q -Tag Selection key]。
要进行操作，您只需在放置Q-Tag的画面上放置[Q -Tag Selection key]。

从菜单栏的 [Tags]中选[T-Tag]。

或单击T(T-tag)图标。

选择每个功能并将其放置在已放置Q-
Tag的画面上。如果要在Q-Tag显示区
域内操作，就需要使用一个“开始”键。
触摸“开始”键，然后光标就会出现在Q-
Tag的显示区域。

1
・从[Mode]选项卡的[Special]中选择[Q-Tag Selection key]。

注意！

如果在一个画面中放置了多个Q-Tag，那么T-Tag将不起作用。

(1) 如何选择T-Tag (触摸屏输入) 

(2) Q-Tag选择键的功能

・Tag工具栏

・菜单栏

1

1

1
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(3) Q-Tag选择键的每个功能

Clear All
Acknowledged Alarms
(清除全部已确认报警)

Clear All Recovered 
Alarms

(清除全部已恢复报警)

Clear Acknowledged 
Alarms

(清除已确认报警)

Clear Recovered Alarms
(清除已恢复报警)

Delete All(全部删除)

清除当前选定报警的累计报警时间。

清除全部累计报警时间。

清除当前选定报警的报警计数编号。

清除全部报警计数编号。

Clear Option Numbers
(清除选项编号) 只有在使用了[扩展功能 + 

块]后才可以使用此操作

Clear All Numbers
(清除全部编号)

Delete(删除)

C
l
e
a
r

Clear All Times
(清除全部时间)

Clear Option Time
(清除选项时间)

Roll Down(下滚)

Roll Up(上滚)

Down(向下)

Up(向上)

M
o
v
e

ACK All
（全部确认）

ACK(确认)
A
C
K

Finish(完成)

Start
（开始）

清除全部已确认的报警。

清除全部已恢复的报警。

已确认的消息将从当前选定报警中删除。

已恢复的消息将从当前选定报警中删除。

清除显示的全部Q-Tag消息。

清除当前行的消息。

使用此键可以将显示数据向下滚动指定的行数。

使用此键可以将显示数据向上滚动指定的行数。

在Q-Tag显示区域将选中的光标下移。

在Q-Tag显示区域将选中的光标上移。

按下该键就会将确认时间添加（并显示）到所有尚未拥有确认时间的消息上。

按下该键就会在光标当前显示的行中显示出确认时间。

此键会在光标消失的同时终止键输入操作。

此键启动在Q-Tag显示区域的操作。按下此键可以在显示区域内出现一个指针。
“保持模式” - 按下Start（开始）键两次会保留Q-Tag的显示，并且即使触发、确
认或恢复了报警，消息也不会被更新。为解除保持模式，请按下Finish（完成）

键。模式解除后，在保持模式期间触发、确认和恢复的报警就会同时显示出来。
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按照设置的报警等级以降序显示报警。如果为多个报警
设置了相同的等级，报警就会按照报警计数的编号顺序
列出，并且首先出现报警计数最多的报警。

Sort Level & 
Number

(按等级和次数排序)

按照设置的报警等级以降序显示报警。如果为多个报
警设置了相相同的等级，报警就会按照时间戳的顺序
列出，并且首先出现最新的报警。

Sort Level & Date
(按等级和日期排序)

以报警编辑器中记录的顺序显示报警。
Sort Alarm
(按报警排序)

以当前在GP上显示的Q-Tag显示顺序的逆序显示报警。
Sort Reverse 

Alarm
(按报警逆序排序)

按报警出现的累计时间以降序显示报警。
Sort All Time
(按总时间排序)

按报警出现编号以降序显示报警。
Sort Number
(按次数排序)

只有在使用

[Use Extended 
Function]
后才可以

使用此操作

按报警出现时间以降序显示报警。
Sort Date

(按日期排序)

S
o
r
t

按下”子显示“键并选中Q-Tag的子显示就会调出指定的子显示画面。
Sub-Display

(子显示)

按下此键可以获得当前选定报警消息的报警

编号。获得的数值就存储在”放置报警光标位

置控制所指定的设备地址内。

只有在使用

[Use Extended 
Function]后
才可以使用此操作

Alarm Information 
Acquisition

(获得报警消息)
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现在放置一个报警消息操作键

现在我们用T-Tag来操作Q-Tag的显示

消息。

以下将说明如何在Q-Tag中放置确认
时间，以及如何使用T-Tag删除Q-Tag
中已确认的报警消息。

从Tag工具栏中单击T(T-Tag)
图标。

在[Mode]的[Special]中选择[Q-Tag 
selection key]。

选择[Start]并选中[Freeze Mode]。

单击[OK]。

像绘制正方形那样将T-Tag放
置到“选择开始”图标上。

１

1 2

3

(1) 打开T-Tag设置

(2) 设置Q-Tag选择键Start(开始键)

(3)放置Q-Tag选择键Start(开始键)

1

1

2

3

1
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可以从[Action]中选择[Sort]以
更改报警显示顺序。然后将T-Tag
放置到画面中的以下这些开关图
形上。

发生时间: [Sort Date]
发生次数: [Sort Number]
累计时间: [Sort All Time]
反向排序: [Sort Reverse Alarms]

从[Action]中选择其它[Q-Tag selection key]来操作Q-Tag。
将下面那些功能的T-Tag放置到画面的开关图形上。
选择终止: [Finish]

确认: [Ack] 的 [Ack]

确认清除: [Clear]的[Clear All Ack Alarms]

向上: [Move]的[Up] 

向下: [Move]的[Down]

21

(4) 设置用于其它操作的[Q-Tag选择键]。

1

2
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本节将说明如何显示按Q-Tag
显示的选定报警消息的详细信
息和报警解决措施。

3.3
子显示
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如何显示每条报警的详细消息和对应措施

・通过使用子显示功能，可以选定按Q-Tag带有图形和字符的全部报警消息，从

而显示选定报警消息的详细消息和对应措施。

触摸Q-Tag上显示的消息。

子显示画面就会根据此消息显示在
画面上。

通过窗口根据每条消息调用文本（词句）并且将其显
示出来。

文本显示

通过窗口根据每条消息调用图形（库）并且将其显示
出来。

库显示

通过窗口根据每条消息调用基本画面并且将其显示出
来。更改画面

活
动
窗
口

根据每条消息调用并显示文本（词句）。文本显示

根据每条消息调用并显示库（图形）。库显示

根据每条消息将显示画面更改为其它画面。更改画面基
本
画
面

・有6种用于子显示功能的设置类型，

如下所示。

(1) 子显示功能示例

(2) 子显示的类型

1

2

1

2
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1. [Base Screen] -> [Change Screen] (使用“Change Screen”进行子显示）

・如果您选择按Q-Tag显示报警消息，就可以根据每条报警消息对显示画

面进行切换。

B10

报警1的详细消息

B11

报警2的详细消息

B1 Q-Tag
报警1

报警1
报警2

报警2
报警1

・如果您选择按Q-Tag显示报警消息，就可以根据每条消息调用并显示图形

库。
B1 Q -Tag

L-Tag
报警1

报警2 报警1的
详细消
息(库)

B1 Q –Tag L -Tag
报警1

报警2

报警2

报警1 B1 Q -Tag
L-Tag

报警2的
详细消
息(库)

触摸!

触摸!

2. [Base Screen] -> [Library Display] (使用“Library Display”进行子显示）

注意!

・只能调用和显示图形。无法调用和显示部件及Tag。
・在基本画面上需要为子画面留出空间。如果它与其它对象发生重叠，则无法

只删除调用的子画面。
・可以调用由L-Tag调用的子画面，以使画面中央与L-Tag重叠。

报警2

报警1
报警2

报警2

报警1
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・如果您选择了按照Q-Tag显示的报警消息，那么就可以根据每条消

息调用文本（词句）并将其显示出来。

B1 Q -Tag
X-Tag

报警 1

报警 2
报警1的
详细消
息(文本)

B1 Q-Tag

X-Tag

报警 1

报警 1

报警 2

B1 Q -Tag
X-Tag

报警 1

报警 2

触摸 !

报警 2

报警 1
触摸 !

・如果您选择了按照Q-Tag显示的报警消息，那么就可以根据每条消息

调用和显示窗口画面。

B1 Q -Tag
U-Tag

B1 Q -Tag
U-Tag

B1 Q -Tag 触摸!

触摸!

U-Tag

3. [Base Screen] -> [Text Display] (使用文本显示进行子显示)

4. [Active Window]->[Change Screen] (使用窗口进行子显示)

・只能调用和显示文本画面中记录的文本（词句）。
・在基本画面上，需要为子画面留下空间。
・如果子画面与其它对象发生重叠，则无法只删除调用的子画面。

・此窗口可以被调用和显示。
・在用于子显示的基本画面上，无需为子画面留出

特殊空间。

・即使子画面与其它对象发生重叠，也可以仅删除调用的子画面。

注意!

报警 2

报警2的
详细消
息(文本)

报警 1

报警 2

报警 1

报警 2
报警2的详
细消息(基
本画面)

报警1的详
细消息(基
本画面)

报警 1

报警 2

报警 2

报警 1

报警 1

报警 2

注意!
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・如果您选择了按照Q-tag显示的报警消息，就可以根据每条消息调用

并显示库（图形）。

・如果您选择按Q-Tag显示报警消息，那么就可以根据每条消息调用和

显示文本（词句）。

5. [Window]->[Library Display] (使用Window和Library Display进行子显示)

6. [Window]->[Text Display] (使用Window和Text Display进行子显示)

・此基本画面可以被调用和显示。
・在用于子显示的基本画面上，无需为子画面特别留出空间。
・即使子画面与其它对象发生重叠,也可以仅删除调用的子画面。

・此文本画面可以被调用和显示。
・在用于子显示的基本画面上，无需为子画面特别留出空间。
・即使子画面与其它对象发生重叠，也可以仅删除调用的子画面。

注意!

注意!

B1 Q -Tag
U-Tag

报警1

报警2
报警1的
详细消
息(文本)

B1 Q -Tag

U-Tag

报警1

报警2

报警2

报警1 B1 Q -Tag
U-Tag
报警2的
详细消
息(文本)

触摸!

触摸!

报警1
报警2

报警2

报警1

B1 Q -Tag
U -Tag

B1 Q-Tag

U-Tag

报警 1

报警 1

报警 2

B1 Q -Tag
U-Tag

触摸 !

报警 2

报警 1 触摸 !
报警 2

报警2的
详细消
息(库)

报警 1

报警 2

报警1的
详细消
息(库)

报警 1
报警 2
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1.为每条报警消息创建一个子画面(Base Screen)。
↓

2. 使用报警编辑器记录每条消息的子显示画面编号。

↓

3. 在Q-Tag中设置子显示功能。

B1 Q -Tag

报警1

报警2

报警1
报警2

触摸!

B10

报警1的详

细消息

此画面就更改为
基本画面[10]。

使用“Change Screen”进行子显示

例如：将[报警1]的子显示画面编号设置为[10]。

可以通过报警编辑器中的子显示画
面编号来设置子显示画面。

如果您选择[报警1]，此画面就会被更改为画面B10。

(1) 子显示设置的流程 (Base Screen -> Change Screen) 

(2) 报警编辑器的设置

11
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选择[Base Screen]的[Change Screen]。

这时会显示出在报警编辑器中设置的子显示
注册号加偏移量的画面。

如果选中了[Direct Selection]，触摸Q-Tag显
示的消息就会显示出子画面。如果没有选中
[Direct Selection]，使用T-Tag的[Q -Tag 
selection key]可以显示出子画面。如果选中
了[Cursor Display]，在选定消息上就会显示

光标。

要点

如何使用偏移量

问：我通过报警编辑器设置了从[1]开始以升序显示的子显示画面编号。但是
自从出现基本画面，[1]到[10]就已经用于显示画面，我必须要通过基本画面创
建一个子画面[11]。我是否必须通过报警编辑器重新记录子显示画面的编号？

答：在这种情况下，您可以使用[偏移]调用并显示从B11开始记录的子画面，而
无需通过报警编辑器重新记录子显示画面的编号。如果偏移量设置为[10]，当
记录为子显示画面[1]的消息以子显示方式出现时，画面编号[11]的画面(偏移量
[10] + 子显示画面编号[1])也会作为子画面显示来。

(3) Q-Tag设置

1

2
3

1

2

3
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1.  为每条报警消息创建子画面(Base Screen)。
↓

2．通过报警编辑器为每条消息记录子显示画面的编号。

↓

3. 为Q-Tag设置子显示功能。

↓

4. 在调用子画面的画面上设置L-Tag。

使用库显示进行子显示

1

可以在报警编辑器的子显示画面编
号中设置子显示的画面编号。

B1 Q -Tag

L-Tag报警1

报警2 报警1的
详细消息

B1 Q -Tag

L-Tag报警1
报警2

报警1

报警2
触摸!

这时就会调用并显示
基本画面[10]。

B10

报警1的
详细消息

如果您选择[报警1]，就会调用基本画面[10]作为子画面。

例如：如果[报警1]的子显示画面编号为[10]。

(1) 子显示设置的流程 (Base Screen -> Library Display)

(2) 报警编辑器的设置

1
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从[Base Screen]中选择[Library Display]。

子显示基本画面的画面编号就会存储在此处
设置的字地址中。此地址必须与子显示使用
的L-Tag的字地址相同。

设置当选择在报警编辑器中将子显示画面编号定义为[0]的消息时显示的画面

编号（不带子画面）。

从“Designated Screen”选项卡中选择
[Indirect]。

・当通过子显示的[Base Screen]-> [Library Display]使用L-Tag时，请进行以

下设置。

将触发类型选择为[None]。

选择数据格式为[Bin]。

设置与在Q-Tag的子显示中设置的字地址

相同的地址。

将画面类型选择为[Base Screen]。

・在子显示中设置的字地址只能是LS区域中用户可使用的地址。

要点

(3) Q-Tag设置

(4) L-Tag设置

1

2
3

1

2

3

4

5

1

2

3

1

2

3

4

5
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• 生产线B线路故障

• 生产线C电源错误

• 生产线A速度错误

补救措施

生产线A速
度错误的
补救措施

什么是清除画面编号？
如果混合设置了带有子画面的报警消息和不带子画面的报警消息（子显

示画面编号设置为[0]），这样就设置了清除画面编号。
如果您以子显示的方式显示报警，并且不使用子画面也不设置清除画面

编号，原先显示的子画面就会保留。如果设置了清除画面编号并且选择了不
带子画面的报警，已经准备清除的画面(在清除画面编号中记录的画面)就会

被原先显示的子画面所替代。因此该子画面就不会再显示。

触摸[生产线A速度错误]。
这时会显示在子显示画面编号中

记录的子画面。

触摸生产线B线路故障

这时会显示在清除画面编号中记录的画面。

例：

• 生产线B线路故障

• 生产线C电源错误

• 生产线A速度错误

补救措施

如果混合了子显示画面编号设置为[0]的消息，

准备清除画面并为其设置Q-Tag的
清除画面编号。

DisplayDisplay
Ｂ1

生产线A速
度错误的
补救措施

显示显示

Ｂ17

要点!
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使用文本显示进行子显示

1. 为每条报警消息创建子画面(Text Screen)。
↓

2.  通过报警编辑器为每条消息记录子显示画面。

↓

3.  为Q-Tag设置子显示功能。

↓

4.  在调用子画面的画面上设置X-Tag。

打开[Editor]并从[New]中选择[Text 
Screen]。

・创建带有文本画面的子显示画面。

为每条消息创建子显示的文本(词句)并
将其保存。

(1) 子显示设置的流程 (Base Screen -> Text Display) 

(2) 创建子画面(文本画面) 

1

2

1

2



实践操作教材

86

B1 Q -Tag
X -Tag

报警1

报警2 报警1的
详细消息

文本画面 [1]

如果您选择[报警1]，文本画面[1]就会作为子画面被调用。

B1 Q -Tag
X-Tag

报警1
报警2

报警1
报警2

触摸!
X1

报警1的
详细消息

选择[Base Screen]的[Text Display]。

用于子显示的文本画面的画面编号就
保存在此处设置的字地址中。
此地址必须与用于子显示的X-Tag的
[Text Screen]中的字地址一致。

设置当选择在报警编辑器中将子显示画面编号定义为[0]的消息时显示的画面

编号（不带子画面）。

例：将[报警1]的子显示画面编号设置为[1]。

可以在报警编辑器的子显示画面编
号中设置子显示的画面编号。

(3) 报警编辑器的设置

(4) Q-Tag的设置

1 2

3

1

2

1

3

1
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将模式[Mode]设置为[Word]。

・在通过子显示的[Base Screen]->[Text Display]使用X-Tag时，

请进行以下设置。

设置与在Q-Tag的子显示中设

置的文本画面字地址相同的地
址。

将数据格式[Data Format]选择为[Bin]。

将显示始行[Display Start Line]设置为[Direct]，而行号[Line No.]
则设置为[1]。

(5) X-Tag的设置

1

2

4

3
2

1

3

4
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使用活动窗口进行子显示

1. 为每条报警消息创建子画面 (Base Screen)。
↓

2. 使用窗口注册创建的子画面。

↓

3. 通过报警编辑器记录每条消息的子显示画面编号。

↓

4. 为Q-Tag设置子显示功能。

↓

5. 在调用子画面的画面上设置U-Tag。

在基本画面上创建子画面并且将其保存。
保存后，从菜单栏的[Screen]中选择[Window 
Registration]。

・在基本画面和每个窗口注册画面上创建一个子
显示窗口。

单击[Add]并选出希望用于带框窗口注册

的位置。

B10

报警1的
详细消
息

B10

报警1的
详细消
息

U1

例：在基本画面[10]上创建子画面并在窗口

[1]中将其记录。

在注册号中输入窗口编号并单击[OK]。

(1) 子显示设置的流程 (Active Window -> Change Screen)

(2) 子画面的窗口注册

1

2

3

2

1

3
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例：将[报警1]的子显示画面编号设置为[1]。

B1 Q –Tag 
U-Tag

报警1的
详细消息

使用窗口[1]记录

如果选择了[报警1]，窗口[1]就会被作为子画面调用。

B1 Q -Tag
U-Tag

报警1

报警2

触摸!
B10

报警1的
详细消息

U1

可以在报警编辑器的子显示画面编
号中设置子显示的画面编号。

在[Active Window]中将[Mode Settings]
设为[Change Screen]。

用于子显示的文本画面的画面编号存储
于此处设置的字地址中。此地址必须与
用于子显示的U-Tag中的字地址一致。

(3) 报警编辑器的设置

(4) Q-Tag设置

报警1

报警2

1

1

2

报警1

报警2

1

2

1
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字地址必须与在Q-Tag的子显示中设

置的字地址一致。

在通过子显示的[Active Window] -> 
[Change Screen]来使用U-Tag时，请
进行以下设置。无论您将设置的U-Tag
放置于画面上的任何位置都可以。

将指定窗口[Designated Window]选择为
[Indirect]。

将数据格式[Data Format]选择为[Bin]。

(5) U-Tag设置

1

32

2

1

3
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使用活动窗口和库显示进行子显示

1. 为每条报警消息创建子画面 (Base Screen)。
↓

2.  通过报警编辑器记录每条消息的子显示画面编号。

↓

3.  在新的基本画面上设置L-Tag。
↓

4.  使用窗口注册创建的L -Tag。
↓

5.  为Q-Tag设置子显示功能。

↓

6.  在调用子画面(L-Tag)的画面上设置U-Tag。

可以在报警编辑器的子显示画面编号中
设置子显示的画面编号。

例：将[报警1]的子显示画面编号设置为[10]。

B1 Q -Tag U –Tag          

报警1

报警2
报警1的
详细消息

B1 Q -Tag

U-Tag报警1
报警2

报警1
报警2

触摸!

B5

Ｌ-Tag

B10

报警1的
详细消息

U1 B5 U1

报警1的
详细消息

如果您选择了[报警1]，就会调用基本画面[10]以用于L-Tag。L-Tag
通过U-Tag调用到基本画面[1]并进行子显示。

(1) 子显示设置的流程 (Active Window -> Library Display)

(2) 报警编辑器的设置
1

L-Tag

1
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在指定画面[Designated Screen]选项栏
中选择[Indirect]。

・在通过子显示的[Active Window]->[Library Display]使用L-Tag时，请进行以
下设置。对于L-Tag，请通过子显示画面（放置Q-Tag的画面）单独创建一个

新的画面并将其放入。

选择触发类型[Trigger Type]为[None]。

选择数据格式[Data Format]为[Bin]。

设置的字地址必须与Q-Tag的子显示
中设置的字地址 (L -tag Word 
Address)一致。

选择画面类型[Screen Type]为[Base Screen]。

在基本画面上创建子画面并将其保存。保
存后，选择菜单栏[Screen]下的[Window 
Registration]。

以窗口注册放置L-Tag的画面。

单击[Add]并选取希望用于窗口注册的位置。

在注册号中输入窗口编号并单击[OK]。

(3) L-Tag设置

(4) 子画面的窗口注册

1

2

3

4

5

2

3

1

2

1

3

2

1

3

4

5
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选择[Active Window]的[Library Display]。

字地址[Word Address]必须与用于子显示的
U –Tag的字地址一致。

设置当选择在报警编辑器中将子显示画面编号定义为[0]的消息时显示的
画面编号(不带子画面)。

设置注册L-Tag的窗口的注册号。

用于子显示的文本画面的画面编号就存
储在此处设置的字地址中。此地址必须
与用于子显示的L-tag的字地址一致。

例：将L-Tag放置在基本画面[5]上。在窗口[1]中注册放置的L-Tag。

B5 Ｌ-Tag B5 Ｌ-Tag U1

在使用窗口注册L-Tag前，请先考虑调用L-Tag的子画面的显示位置和大小。

窗口注册范围以外的部分将不会显示出来。

(5) Q-Tag设置

1

2

5

3
4

3

2

1

4

5
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字地址必须与Q-Tag的子显示中设置

的字地址一致。

在使用子显示的[Active Window] -> [Library Display]的U-Tag时，请进
行以下设置。无论您将U-Tag放置到画面上的任何位置都可以。

在指定窗口[Designated Window]
选项栏中选择[Indirect]。

选择数据格式[Data Format]为[Bin]。

(6) U-Tag设置

1

32

3

2

1
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使用活动窗口和文本显示进行子显示

1. 为每条报警消息创建一个子画面(Text Screen)。
↓

2. 通过报警编辑器记录每条消息的子显示画面编号。
↓

4. 在新的基本画面上设置X-Tag。
↓

5. 使用窗口注册创建的X-Tag。
↓

3. 为Q-Tag设置子显示功能。
↓

6. 在调用子画面(X-Tag)的画面上设置U-Tag。

可以在报警编辑器的子显示画面编
号中设置子显示的画面编号。

打开[Editor]并选择[New]中的[Text Screen]。

通过文本画面创建用于子显示的画面。

创建子显示的文本(词句)。

(1) 子显示设置的流程 (Active Window -> Text Display) 

(2) 创建子画面 (文本画面)

(3) 报警编辑器的设置

1

1

2

3

2

1
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B1 Q-Tag

U-Tag报警1

报警2 报警1的
详细说明

B1 Q -Tag

U-Tag报警1

报警2

报警1

报警2

触摸!

将文本画面[1]中记录的[报警1的详细说明]调入带有X-
Tag的基本画面[10]。然后，将为基本画面[10]调用的
[Details of Alarm 1]调入带有U-Tag的基本画面[1]并以

子显示的方式将其显示。

B10X1

报警1的
详细说明

U1

Ｘ-tag

B10 U1

报警1的
详细说明

例：设置[报警1]的子显示画面编号为[1]。

如果您选择了[Alarm 1]，则文本画面[1]就会被调入X-Tag。然后X-Tag
会被调入带有U-Tag的基本画面[1]并以子显示的方式显示。

选择模式[Mode]为[Word]。

・在使用子显示的[Active Window]-> [Text Display]的X-Tag时，请进行

以下设置。

文本画面的字地址必须与在Q-Tag
的子显示中设置的字地址一致。

选择数据格式[Data Format]为[Bin]。

将显示开始行[Display Start Line]选择为[Direct]，而行号[Line No.]
则设置为[1]。

(4) X-Tag设置

1

2

4

3
3

2

1

4
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在基本画面上创建子画面并将其保存。
保存后从菜单栏的[Screen]中选择
[Window Registration]。

・使用窗口注册放置X-Tag的画面。

单击[Add]并选取希望用于窗口注册的位

置。

在注册号中输入窗口编号并单击[OK]。

例：将X-Tag放置到基本画面[10]中。在窗口[1]中记录放置的X-Tag。

在窗口注册X-Tag前，考虑调入X-Tag的子画面的显示位置和大小。窗口注册

范围以外的部分不会以子显示的方式显示。

B10

X-Tag

(5) 子画面的窗口注册

B10

X-Tag
U1

1

2

3
3

2

1
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选择[Active Window]的[Text Display]。

字地址[Word Address]必须与用于子显示的U-Tag的字地址一致。

设置当选择在报警编辑器中将子显示画面编号定义为[0]的消息时显示的画

面编号（不带子画面）。

用于子显示的文本画面的画面编号就保
存在此处设置的字地址中。此地址必须
与用于子显示的X-Tag的[Text Screen]字
地址一致。

设置已经注册了X-Tag的窗口的注册号。

(6) Q-Tag设置

1

2

4

5

3

3

2

1

4

5
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字地址[Word Address]必须与Q-Tag的
子显示中设置的字地址一致。

・在使用子显示的[Active Window] -> [Text Display]的U-Tag时，请进行以
下设置。无论您将U-Tag放置到画面上的任何位置都可以。

在指定窗口[Designated Window]选项栏
中选择[Indirect]。

选择数据格式[Data Format]为[Bin]。

(7) U-Tag设置

1

３２

3

2

1
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现在显示子画面

以下我们使用Q-Tag来显示报警概要。

以下将说明如何创建报警概要显示的扩展
功能(Q-Tag)以显示报警概要。它将通过
X-Tag的子显示来实施报警相关的初始补
救方法。另外还会按照报警编辑器、Q-
Tag设置和X-Tag设置上的消息记录顺序

进行说明。

1.  为每条报警消息创建一个子画面(X1至X17)。
↓

2.  在报警编辑器中记录每条报警的子显示画面编号。
↓

3.  为B11的Q-Tag设置子显示功能。
↓

4.  创建窗口画面以显示详细画面消息。
（Ｂ303：Ｘ设置，窗口注册）

↓
5.  设置U-Tag以在B11上调用窗口画面。

・此次使用[Active Window]的[Text Display]以设置子显示。

通过文本画面编辑子画面。

・子显示功能设置的流程

单击[New]图标并选择[Text 
Screen]，然后单击[OK]。

1

(1) 创建子画面。打开文字画面。

1
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输入在文本画面的框中显示的处理方法。
输入完成后，请将其保存为文本画面[1]。

选中[Mode Settings]中的[Text Display]。

将字地址[Word Address]设置为[LS30]
(与X-Tag的地址相同)并且将清除画面
编号[Erase Screen No.]设置为[17]。

将字地址[Word Address]设置为[LS31](与U-Tag的地址相同)并且设置窗
口注册号[Window Registration No.]为[7]。

选中[Direct Selection]和[Cursor Display]。

打开[Q-Tag Settings]中的[Sub Display]
并选择[Active Window]。

1

2

3

1

4

(3) 现在设置子显示

(2) 在文本画面中输入[Details]或[Remedies (countermeasure)]

3

2

1

1

4
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完成子显示的设置后单击[OK]图
标，这时就会显示出 。将 放

置到希望显示子画面的位置。已
经放置 的位置与调入的子画面

的左上部分发生重叠。

从工具栏中单击打开画面(Open Screen)
图标。

选择B303的[X -Tag (Sub)]。

单击[Open]。

2

3

1

1

(4) 设置子画面的显示位置

(5) 打开基本画面[B303]

3

2

1

1
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在开始时打开基本画面[B303]。

单击Tag工具栏上的X(X-Tag)图标。

选择[Word]并将字地址[Word 
Address]设置为[LS30]，而数据格
式[Data Format]则设置为[Bin]。

将显示开始行[Display Start Line]设
置为[Direct]，而行号[Line No.]则
设置为[1]。

将显示大小[Display Size]设置为
[1x2(f)]，而显示行号[No. of Display 
Lines]为[3]，显示字符数[No. of 
Display Char.]设置为[18]。

按照您的需要设置显示颜色。

完成设置后，请单击[OK]。

1

1 2

1

2

3

(6) 打开X-Tag设置以调用文本画面

(7) 设置X-Tag的[Mode]

(8) 设置X-Tag的[Size/Style]

3

2

1

1

2

1
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X-Tag使通过文本画面创建的文本显示在画面上。

要点

X-Tag设置

Bit: 显示的文本画面不变。

Word: 显示的文本画面可变。将

画面编号存储到字地址中，并且
指定要显示的文本画面。

Word Address: 设置存储要显示

文本画面的画面编号的字地址。

Data Format: 设置存储于此字地

址中的文本画面编号的数据格式。

通过X-Tag设置要显示的文本画面的起始行。

Direct: 起始行不变。

Indirect: 设置字地址并存储显示起始行，然后进行指定。

设置通过更改显示起始行进行滚动的消息数量。
可以按照以下所示的公式计算通过X-Tag的显示起始行。

1 + ([行号] – 1) X [滚动行数]

1

2 3

4

3

2

1

4
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将X-Tag放置到画面中需要的位置。

放置完成后请将其保存。

从菜单栏的[Screen]中选择[Window 
Registration]。

单击[Add]。

选取记录为窗口的范围。
记录的范围就称为子画面。

将注册号[Registration No.]设置为[7]，
并且按照您的需要设置[Description]。

单击[OK]。

1

1

2

3

5

(9) 将X-Tag放置到画面上

(10) 窗口注册X-Tag

3

2

1

4

5

1

4
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打开基本画面[B11]。

单击Tag工具栏的U-Tag图标。

设置字地址[Word Address]为[LS31]，指定
窗口[Designated Window]为[Indirect]，而
数据格式[Data Format]为[Bin]。

单击[OK]。

首先打开[Designated Window]。

将U-Tag放置到任意位置。

无论将其放置到画面的任何位置都可以。

如果您触摸了在Q-Tag显示区域中显示

的报警消息，该报警消息的对应措施就
会显示到画面上。

1

1

2

1

2

(11) 放置U-Tag以调用X-Tag

(12) 设置U-Tag

(13) 放置U-Tag

(14) 转换画面并运行检查

2

1

1

1

1
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本节说明如何将静态存储器(SRAM)中的
报警数据作为CSV文件存储到CF卡中。

3.4

CF卡存储设置
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如何将记录的报警数据保存到CF卡中

・通过Q-Tag显示的数据存储于GP的静态存储器(SRAM)中。
这里将说明如何将静态存储器(SRAM)中保存的报警数据保存到CF卡中。

要将静态存储器(SRAM)中保存的报警数据保存到CF卡中，点击[GP Setup]
->[Extended Function Settings]->[CF Card Operation Settings]中以进行设

置。

・需要保存报警数据？

①

单击[GP Setup]。

・打开[Project Manager]。

单击[Extended Function Settings]。

对[CF Card Operation Settings]进行设置。

(1) 如何打开CF卡操作设置

1

2

3

3

2

1

1
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模式

文件编号

为将报警数据保存到CF卡中，请选中
[Data Storage]并设置[Control Word 
Address]。
[Control Word Address]分为[Mode](指
定命令和状态)和[File No.](其中指定要
保存文件的编号)。

例如：
控制字地址: 此例中为D100

为将静态存储器(SRAM)中保存的数据保存到CF卡中，请先设置文件编号并
保存到[File No.]，然后在[Mode]中编辑命令。完成此过程后，就出现[Mode]
中编辑的状态。下表显示了每条命令/状态的详细说明。

(2) CF卡操作设置

(3) 如何将备份数据保存到CF卡中

D100
D101

1

1
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块5数据0  0  0  9 h

块4数据0  0  0  8 h

块7数据0  0  0  B h

块6数据0  0  0  A h

报警日志/块3数据0  0  0  7 h

文件编号错误0  4  0  0 h

没有载入数据(当没有指定数据时)0  3  0  0 h

未安装多个装置/CF卡未插入/CF卡访问转换关闭0  2  0  0 h

编辑错误0  1  0  0 h

顺利完成0  0  0  0 h状态

记录数据循环自动保存结束0  0  2  1 h

记录数据循环自动保存开始0  0  2  0 h

块8数据0  0  0  C h

历史报警/块2数据0  0  0  6 h

活动报警/块1数据0  0  0  5 h

采样数据0  0  0  4 h

趋势图数据0  0  0  3 h

记录数据0  0  0  2 h

配方数据命令

说明字数据模式

保存报警数据时，选择从0005h到000Ch之间的数据并将这些数据写入控制字地址(模式)
中。完成保存后，状态0000h就被写入。如果没有顺利完成保存，就会写入0000h以外

的状态。

0  0  0  1 h
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・数据按照以下文件名保存。

Z6*****.CSV块6数据

Z7*****.CSV块7数据

Z8*****.CSV块8数据

Z5*****.CSV块5数据

Z4*****.CSV块4数据

ZG*****.CSV日志/块3数据

ZH*****.CSV历史/块2数据

ZA*****.CSV活动/块1数据

报警数据\alarm
ZS*****.CSV采样数据

ZT*****.CSV趋势图数据\trend

ZC00001.MRMGP备份数据(MRM文件)\mrm

视频截图

CP*****.JPG画面截图\capture

ZO*****.BIN声音数据

ZI*****.BIN图形画面\date

ZL*****.CSV记录数据\log

ZR*****.CSVCSV传输功能数据

ZF*****.BIN配方数据\file

文件名要保存的数据文件夹

(4) 保存在CF卡中的数据文件名
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・将静态存储器(SRAM)中保存的报警数据(历史记录)保存到CF卡中，并设
定文件编号为[2] (控制字地址设置为[D100])

设置要保存到控制地址 + 1(D101)中的文

件编号。
（例如：将[0002h]写入D101)

如果您要将[0005h到000Ch]命令写入控制
字地址 + 0 (D100)，就会保存每个报警数

据。要写入的命令根据报警数据的类型而
变化。
（例如：将[0006h]写入D100)

正确完成数据保存后，[0000h]就被写入控
制字地址 + 0 中。如果保存数据不正确，

则会写入其它错误状态。
(例如，正确完成数据保存后，就会生成
[ZH00002.CSV] 文件）

例：保存报警数据

④ 打开保存的报警数据(历史记录)，这时将显示以下消息。

* 在打开使用Excel保存为CSV的报警数据时，显示格式会与在GP画面

上显示的格式有所不同。

D100    模式

D101 文件编号

①

D100    模式

D101    文件编号

②

0000h

0002h

③

0006h

0002h

D100    模式

D101 文件编号

0000h

0002h
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第四章 多语言在线切换

• 多语言切换

• 文本索引表
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本节将说明如何使用多语言在线切换功能。

4.1

多语言切换
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1 Start
2 Stop
3 Running

4 …

1. 多语言在线切换功能需要在GP377/77R/2000系列上，GP-PRO/PBIIIV6.0
版本以上软件支持。

2. 普通的文本内容或部件的标签，可以用文本索引表的索引编号方式进行处理，

这样可以非常方便地在运行时改变文本索引表，从而实现多语言的在线切换，不

用分别对不同语言重复做画面。

文本索引表1（英语）

1 开始

2 停止

3 运转

4 …

文本索引表2（中文）

Start Stop 开始 停止

多语言在线切换

索引编号1 索引编号2 索引编号1 索引编号2

要点
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本章将说明多语言文本索引表切换的控
制地址、表的类型和名称及表的设置。

4.2
多语言文本索引表
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首先，需要选中“Text Table (ON/OFF)”。

输入控制多语言表切换的控制地址，这是一个字地址，GP运行时改变
它的值就可以改变显示所使用的语言表。

在工程管理器界面，选择[Screen/Setup] [Text table]菜单。弹出“Text 
Table Editor”窗口。

(1)多语言切换的控制地址

例：上例中的地址:

(2)表的语言类型、名称

下拉选择框选择每个表，可以在“GP Font”里选择相应使用的语言类型。
例如:上图例中的，1:Table1使用的是ASCII(英文)；2:Table2使用的是CHINA
(GB2312中文)。

针对每种语言表，需要逐条对应地在下面的表格中输入相应的文字。

表的语言类型选择

窗口左面有一个下拉选择框，分别对应“Table1-Table16”。最多支持16种语言表。

0100                               
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下拉选择框选择每个表，依次选择菜单[File] [Table Name Change]
命令，可以改变表的默认名称“Table n”。

表的名称

初始语言表的设置

在“Text Table Editor”编辑窗口，选择[File] [Init 
Table Setting…]可以设置GP运行时的初始语言表。
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在基本画面里需要输入文字的地方，例如[Draw] [Text]，或者某个

部件的“Label”下，就可以使用前面定义好的文本索引表了。

(3)编辑画面时使用的语言表

例如下面输入的静态文字

选择绘图静态文字时，出现“Text”属性对话框。如上图右边。修改静态文字

时，鼠标双击静态文字，出现“Text”属性对话框。

如果需要直接输入文字内容，可以选择“Direct”方式。以这种方式输入的文字

不能进行在线语言切换的。

如果使用“Browse Text Table”方式，就可以在下面的下拉列表框里选择前面

定义过的字符串作为文字输入。因为它是用这个字符串在文本索引表的索引编
号来对应的，所以运行时只要改变所使用的语言表，就可以进行多语言切换了。

例如下面输入的按钮名称

3

2

1

1
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选择绘图按钮标签时，出现“Bit Switch Settings”属性对话框。如上图右边。
修改按钮标签时，鼠标双击按钮，出现“Bit Switch Settings”属性对话框，切换到
“Label”标签。如果需要直接输入文字内容，可以选择“Direct”方式。以这种方式输入的
文字是不能进行在线语言切换。如果使用“Browse Text  Table ”方式，就可以在下
面的下拉列表框里选择前面定义过的字符串作为ON/OFF状态时的文字输入。因为

它是用这个字符串在语言表里的索引编号来对应的，所以运行时只要改变所使用的
语言表，就可以进行多语言切换了。

编辑画面时的预览

依次选择[View]        [Tool bar]        [String Table]命令，可以在编辑窗
口里打开/关闭以下的文本索引表快捷工具条。

切换当前显示的语言表 启动“Text Table Edit”

(4)运行画面时改变语言表

通过这个工具条上的选择，可以在画面上快速预览相应的语言画面。

可以在“Text Table Editor”编辑窗口设置初始语言表。

前面介绍了设置多语言的控制地址，改变多语言表的控制地址的值，就可
以进行语言表的切换。其值范围1-16。例如前面的例子中，LS0100的值为
1时，以Table 1-ASCII(英文)显示；LS0100的值为2时以Table2-
CHINESE(GB2312中文)显示。具体改变控制值的方法很多。例如:可以做
一个专门的语言选择画面，选择英文时，通过“Word Switch”部件将常数“1”
写入LS0100；选择中文时，通过Word Switch部件将常数“2”写入LS0100。

(5)多语言表的限制

以下内容是不能通过多文本索引表进行切换的。
[A-tag]字符串显示功能
[K-tag]字符串显示功能
[S-tag]字符串显示功能
[P-tag]格式化字符串显示功能
[X-tag]显示功能

配方、数据记录等特殊部件。

1

1

1
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第五章 数据记录

• 显示记录数据



实践操作教材

122

什么是数据记录画面？

・它有什么用途？

可以在任何时间将与控制器相关的数据记录到GP中。记录的数据可以在
GP上显示，或保存到CF卡并复制到计算机中用于管理生产结果。

记录的数据会保存到GP中用于备份的静态存储器中。根据GP类型的不

同，用于备份的静态存储器的性能也会有所不同。请在考虑静态存储器的
容量后设置记录参数。
(例如：20个字的数据重复100次(一块)的大小约为5KB)
请参阅[Tag参考手册]，获得关于此公式的详细说明。

・注意 (创建画面时) 

・关于数据记录画面

记录的数据显示在画面上。

触摸以滚动记录数据列表。

每次在触摸时会记录数据。

每次记录了一组数据后就会变亮。

记录文件满时该位地址控制的指示灯亮。

触摸以清除记录的数据。

1

2

6543

3

2

1

6

5

4
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本节说明在画面上显示已记录数据的方法。

5.1
显示记录数据



实践操作教材

124

记录数据

・数据记录用于记录并显示控制器的数据。
数据记录功能可用于在特定周期（每周）或任意时间保存显示的控制器数据。
记录的数据可以显示在画面上、打印出来或保存到CF卡中。

记录功能的示意图

D100 D101 D102
1st 10 9 13
2nd 11 13 15
3rd 16 15 18
4th ・・・ ・・・ ・・・

④ 显示设置
(记录显示) 

LS
区

触发器设置: 设置要进行记录的控制器地址和触发地址。

显示设置: 可以使用记录显示部件在GP上显示记录数据。

写入LS设置: 可以按照数值显示、柱状图或曲线图的格式记录并显示写入GP

LS区中的记录数据。

打印设置: 可以使用打印机将记录数据打印出来。

CF卡保存设置: 可以使用CSV格式将记录数据保存到CF卡中。

可以通过Excel使用CSV文件。

备份

静态存储器

GP中

①

ＣＦ
卡

打印机

触发器设置

②

⑤

④

③

3

2

1

5

4
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从工程管理器[Project Manager]中选择[Data Logging Settings]。

使用[Display]选项卡设置

记录数据的显示格式。

打开画面编辑器并将记录显示放置到基本画面上。

数据记录设置步骤

将画面数据传输给GP。

使用[Trigger Settings]选项卡

设置记录数据的范围
和触发方式

※在设置记录时必须关闭画面编辑器。

※如需要，设置其它项目。

在GP画面上记录显示的示例

Time Line A Line B Line C Line D
1st 11:50:00 100 200 300 400
2nd 12:00:00 101 201 301 401
3rd 12:10:00 102 202 302 402
4th
5th
Total 303 603 903 1203

3

2

1
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触发器设置

从菜单栏的[Screen/Setup]上选择
[Data Logging Settings]。

(1) 选择数据记录的设置

选择设置记录操作。

(2) 触发器设置的内容 (位方法) 

Special : 设置最多32个字。

Economy : 设置内容受到限制，

但是和记录字数一样，最多可以设
置255个字。

Bit Method: 设置成为启动记录的触发器的位。
如果位是[ON]状态，那么随时可以记录数据。
Time Method: 以指定的间隔记录数据。

可以在每周固定的周期记录数据。

Data Logging Start Address: 设置数据记录的开始地址。

No. of Words: 设置要记录的字数。

Read Count: 设置块的记录频率。

Block Count: 设置块的数量。

1

1 2

3

4

5

3

2

1

4

1
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(3) 触发器设置的内容 (时间方法) 

Data Logging Auth. Bit Address: 设置位地址以允许记录。如果指定的位

地址为[OFF]，则不会有数据记录，即使到了开始处理的时间也是如此。

Block’s Finish Bit Address: 设置记录了一个块时[ON]的位地址。

PLC Trigger Bit Address: 设置开始记录的触发器地址。

GP_ACK Bit Address: 设置每次保存数据时指示灯成[ON]的位地址。

File Full Bit Address: 设置保存[Frequency] x [Block Count]时开关成[ON]的位地址。

Data Clear Bit Address: 设置清除已记录数据的位地址。[ON]清除数据。
Loop: 在需要设置频率(块数)时使用新数据覆盖旧数据。

Start Time: 设置开始记录的时间

Duration: 设置记录的间隔时间。从开

始到结束期间的记录数据作为一个时期
内的一个块进行处理。

Read Count: 设置为块记录数据的频率。

结束时间自动取决于设置的频率。
1

2

2

1

5
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Time Line A Line B Line C Line D
1st
2nd
3rd
4th
5th
Total 0 0 0 0

Time Line A Line B Line C Line D
1st
2nd
3rd
4th
5th
Total 0 0 0 0

设置记录提示 ①

首先确定要记录数据的大小。最大数量为255个字。
(特殊模式和经济模式) 

・如果使用不超过32个字 ・・・特殊模式
※记录数据可以划分成多个块。

->具有相同频率的数据组就被划分到多个单位 (块) 
画面显示也可以为每个块进行划分。

※可以选择使用或不使用循环操作。
->“设置频率 x 块数”会被记录。然后，在下个触发器开始后，

第一个数据就被覆盖。这就称为循环操作。如果选择“不使用循环操作”，
则新数据就会被忽略。

5次/天 x 7块 = 35
次/周

示例: 每天记录五次并分为七

个块，每个块用于一天，并且
每周进行允许操作。

S
S
F
T
W
T
M

如果指定“使用循环
运转”，在记录完七

个块后，最旧的数
据就会被新数据覆
盖。

・如果不超过255个字 ・・・经济模式
记录的字数会增加，但是块不会被分割

（固定为一块，将采用循环运转。
在记录达到预定的
时间后，旧数据将
被新数据所覆盖。

100 次/ 块

示例：数据被记录100
次，从101次起，第一个

数据就会被覆盖。

Time Line A Line B Line C Line D
1st
2nd
3rd
4th
5th
Total 0 0 0 0

Time Line A Line B Line C Line D
1st
2nd
3rd
4th
5th
Total 0 0 0 0

Time Line A Line B Line C Line D
1st
2nd
3rd
4th
5th
Total 0 0 0 0

周一 周二 周三 ・・・周日

此画面显示可以按每
块进行转换。

画面上仅显
示一个块。

要点
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・位方法: 每次指定的位[ON]时进行记录。
每次PLC中的位[ON]时依次记录。

->如果您已经确定了块数和循环操作，请按以下显示设置四个位地址。
・PLC触发器的位地址 <- 每次为[ON]时记录。
・GP_ACK的位地址 <- 每次完成保存过程后，GP就会被自动置[ON]
・文件全部位地址 <- 每次完成预定频率的保存后,GP就会被自动置[ON]
・数据清除位地址 <- 清除静态存储器中的数据。

设置记录提示 ②

决定记录的时间(位方法和时间方法) 

・时间方法: 在设定时间记录
它监控内部GP计时器并在设定时间进行记录。
示例: 任意时期，例如每天下午5:00、每隔十分钟、每小时等。

-> 如果您确定了开始时间、完成时间、频率、块数、循环操作等，
请按照以下显示设置四个位址。
・记录认可的位地址 <- 在预设时间[ON时进行记录。
・块的完成位地址 <- 每完成17个块，GP就会被自动置[ON]。
・块全部位地址 <- 完成了预定的保存频率后，GP就会被自动置[ON]。
・数据清除位地址 <- 清除静态存储器中的数据。

要点
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显示设置

设置在画面上显示记录数据并将数据保
存到CF卡中。

(1) 选择显示设置

○○○○○
○○○○○
○○○○○
○○○○○
○○○○○
○○○○○
○○○○○
○○○○○
○○○○○
○○○○○

○○○○○
○○○○○
○○○○○

○○○○○
○○○○○
○○○○○

○○○○○
○○○○○
○○○○○

○○○○○
○○○○○
○○○○○

○○○○○
○○○○○
○○○○○

*****
*****
*****
*****
*****
*****
*****
*****
*****
*****

*****
*****
*****
*****
*****
*****
*****
*****
*****
*****

****
*****
*****
*****
*****
*****
*****
*****
*****
*****

*****
*****
*****
*****
*****
*****
*****
*****
*****
*****

*****
*****
*****
*****
*****
*****
*****
*****
*****
*****

块名称的行数
(1-3) 

数据行数
(1 – 21000)

计算行数
(1 – 4) 

数据字符(1 – 16) 
数据记录编号 (1 – 60) 

字符/项目数
(1 – 16) 

<行显示设置/列设置>

Display Block Name: 设置数据显示块名
称。

No. of Block Name Rows: 设置以多行
显示块的名称。

No. of Data Rows:设置显示数据行数。

No. of Calc. Rows: 设置计算用的行数。

Display Block Name: 设置以输入和显示块名称。

No. of Char/ Item: 设置块名称的最大字符数。

No. of Data Col.: 设置数据显示的列数。

Data Char. Size: 设置数据显示的字符大小。

No. of Char/ Data: 设置数据显示的字符数。

Preview: 预览设置的内容。

1 2 3

4
3

2

1

4
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设置记录数据的显示格式。输入任意字
符以用于在以上列出的单元格内进行固
定显示。

(2) 显示设置的内容

设置显示行和列项目的颜色。

从[Data]和[Char Col.]中选择对每列的分类。

从[Total]、[Average]、[Max.]或[Min.]中选择数据

计算设置，并且设置单个大小、样式和报警设置。

从[Value]、[Time]和[Char Column]中选择以用于每列

的分类。
Value: 分别选择数据类型、大小、样式和报警设置。

Date/Time: 选择以[Date]或[Time]数据格式显示，并

且设置字符数和大小/样式的颜色。
Char. Col: 设置字符数并且显示大小/样式的颜色。

1 2

3

4

3

2

1

4
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打印设置

选择使用与GP连接的打印机来打印记录

数据。

(1) 选择打印设置

选择要打印的行数和列数。

Block Unit: 选择以块为单位打印。

通过使用[Control Word Address]进
行打印。

Realtime: 每次记录时打印。

※如果指定了[Loop]，则只有
[Realtime]被启用。

Control Word Address: 设置操作打印的字地址。

Print Completed Bit Address: 如果打印完成，此处设置的

位地址则变为[ON]状态。

※ 只有在用于[Block Unit]时才会启动此设置。

1 2

3

4

3

2

1

4
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设置显示数据。可以在列出的单元格中输入字符串。

(2) 打印设置的内容

从[Data]、[Char Col.]或[Border]中选择对每行进行分类。

从[Total]、[Average]、[Max.]或[Min.]中选择数据计算的设置并设置[Size/Style]。

从[Numerical Value]、[Date/Time]、[Char. Col.]或[Border]选择每列的分类。

Numerical Value: 分别设置数据格式、[Size/Style]和报警设置。

Date/ Time: 选择是否以数据格式显示[Date]或 [Time]，以及设置字符数和大

小/样式及颜色。
Char. Col.: 设置字符数并显示大小/样式的颜色。
Border: 边框设置。

1

2

3

3

2

1
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写入LS区设置

通过将数据写入LS区，可以显示数值或图形，以及记录数据。

(1) 写入LS区设置的内容

将记录数据存储到LS区。

Control Word Address: 设置将记录数据写入

LS区时的控制字地址。

Write to LS Address: 设置作为写入目的地
的LS地址的起始地址。

Write Complete Bit Address: 设置当

数据写入LS地址时处于[ON]状态的位地

址。当位地址处于开启状态时，将关闭

PLC中的位。

所有数值列的计算数据都可以批量(块单位)存储到LS区。
Control Word Address : 设置将计算数据写入LS区时的控制字地址。
Write to LS Address : 设置写入目的LS区的起始地址。
Write Complete LS Address : 设置数据写入LS区时需要[ON]的位地址。
当位地址处于开启状态时，将关闭PLC中的位。

1

2

2

1
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设置记录显示

・ 以记录设置中的格式记录的数据可以在GP中使用记录显示进行显示和编辑。
现在我们将说明要在记录显示中设置的内容。

从画面编辑器中打开基本窗口，并且从菜单的[Parts]选择[Logging Display]。

或单击[Logging Display]图标。

(1) 选择记录显示

设置存储要显示的块编号的字地址。

(2) 常规设置的内容

※此处使用了[Place Library]中的一个特殊键盘。它不在

本教程中使用。

Data Edit : 如果选择，就可以通过触

摸显示的数据对其进行编辑。
Interlock Address : 设置编辑数据

时是否互锁。如果启用，则只有互锁地
址为[ON]时才能编辑数据。

・部件工具栏

・菜单栏

1

1

2

1

2

1
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设置显示区域的边框类型。

(3) 常规设置的内容

设置滚动数据时是否滚动合计。
如果禁用,则在滚动显示屏时,合计行不

会显示在常规画面中。

设置清除记录显示中的数据显示时使用
的颜色。

(4) 颜色设置的内容

选择在记录显示中滚动数据显示时
的特殊滚动开关，并且设置滚动计数。

(5) 开关设置的内容

Row : 设置要显示项目的行数。范围是(0 －40)。
Column : 设置要显示项目的列数。范围是(0－25)。
Spacing : 设置以点单位计算的行间距。范围是(0-10)。

设置自动放置的特殊开关的形状
和颜色。

(6) 开关形状/颜色的设置内容

2

3

1

1

1

1

3

2

1

1

1

1
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[设置流程] 

1. 设置记录。
2. 打开基本画面[B50]。
3. 设置/放置记录显示。

说明创建数据记录画面的方法。

从菜单栏的[Screen/Setup]中选择[Data
Logging Settings]。

选择[Logging (ON/OFF)]并选择[Special]。

选择[Bit Method]。

将[Data Logging Start Address]设置为[D300]，
[No. of Words]设置为[4]，[Read Count]设置为
[8]，而[Block Count]设置为[1]。

将[PLC Trigger Bit Address]设置为[M220]，[GP_ACK Bit Address]设置为[M221]，
[File Full Bit Address]设置为[M222]，而[Data Clear Bit Address]设置为[M223]。

现在创建数据记录画面

1

2

3

4

1

(1) 如何打开记录设置

(2) 如何设置记录操作

3

2

1

4

1
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选择[Display]选项卡并启用[Display ON/OFF]

按如下所示设置[Row Settings]和[Column Settings]

<Row Settings> <Column Settings> 

No. of Block Name Rows:1  No. of Char./Item: 8
No. of :Data Rows :8 No. of Data Col.:5
No. of Calc. Rows: 1

Data Char 8 ×16
No. of Char./Data: 8

在每列中输入块名称。
从左侧依次输入[Time]、[Line A]、[Line B]、
[Line C]和[Line D]。

在每行中输入块名称。
从上开始依次输入[1st], [2nd], [3rd], [4th], 
[5th],  [6th], [7th], [8th]以及[Total]。

1

1

2

(3) 如何设置显示格式

(4) 如何输入块名称

1

2

1
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单击[Date/Time] (Time)的字符块并
选择整列。

单击[Settings]图标。

单击[Data Format]选项卡并择[Time]。
选择[hh:mm]作为[Display Format]并
单击[OK]。 设置完成后单击[OK]。

单击[Data Format]选项卡并在[Address Offset]
中设置[1]。然后单击[OK]。
在为[Line B]设置地址偏差时，对[Line C]设置
的地址偏差为[2]，而[Line D]的地址偏差为[3]。
※ 如果没有设置地址偏差，就会显示所有列的

记录起始地址数据。

在使用[Time]列时，单击[Value] (Line B)
的字符块并选择整列。然后单击[Settings]。

12

3

1

(5) 如何设置时间显示

(6) 如何设置数值显示

3

2

1

1
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单击[Total]范围并选择全部行。

单击[Settings]图标。

选择[Total]并单击[OK]。

・单击[Preview] 查看此处设置的显示格式的完整图形，如下图所示。

预览 <示例> 

1

2

3

(7) 如何设置计算显示

3

2

1

要点
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打开画面编辑器并将[Logging Display]放置到基本画面B50中。

将[Block Number Address]设置为[D110]。

按照您的需要设置[Border Type]。
将[Row]设置为[7]而[Column]设置为[6]。

1

1

1

(8) 如何选择记录显示

(9) 如何设置信息

(10) 如何设置显示格式

1

1

1
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按照您的需要设置[Erase Color]。

启用[Scroll Up]和[Scroll Down]并设置
滚动行数为[1]。

按照您的需要选择开关的格式/颜色。

(11) 如何设置颜色

(12) 如何设置开关

(13) 如何设置开关格式/颜色

1

1

1
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如果可以显示在记录设置中设置的整个显示范
围，则无需使用滚动键。

单击[Place]以放置记录显示部件。

(14) 如何放置记录显示

1

要点
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・在PLC侧的梯形图程序示例

从PLC记录到GP的注意事项

在使用PLC梯形图程序记录到GP中时，请注意以下要点：
1: PLC的触发器地址必须为[ON]直到GP完全读取了数据为止(相当于直到
GP_ACK 位地址ON为止)。
读取数据越多(记录字数)，读取时间越长。
2: GP_ACK 位地址会在PLC触发器地址[OFF]时自动置[OFF]。

① 在PLC侧将PLC触发器位地址[ON]。
② GP开始读取记录数据。
③ GP完成读取记录数据。
④ GP自动将GP_ACK位地址置[ON]。
⑤ 如果GP侧的GP_ACK位地址[ON]，PLC触发器位地址会被置[OFF]。
⑥ 如果GP发现PLC触发器位地址[OFF]，他会自动将GP_ACK位地址置[OFF]。

PLC触发器位地址
(PLC侧)

GP_ACK位地址
(GP侧)

读取数据
(GP侧)

读取记录数据

①

② ③

④

⑤

⑥



实践操作教材

145

第六章 配方功能

• 配方设置
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FLASHEPROM
(内存)

什么是配方画面? 

・它为什么有用？

它可以批量将不同的多个数据组(配方)从GP写入连续的PLC地址中。它还可以在
GP中读取和编辑连续的PLC地址并重新将其写入PLC。

此配方数据保存在(※)GP的FEPROM中。GP画面数据也保存在其中。
因此，请注意可能由于画面数据占用了全部存储空间，而导致没有空间保存配方。
※ 配方数据也可以存储到CF卡中。

・注意 (创建画面时) 

・配方画面

将记录的配方项目显示到画面上。

触摸[读取指示]以显示项目名称。
在显示项目名称时[接收完成]灯会亮起。

对其触摸可将灯关闭。

触摸[SRAM -> PLC]以将配方数据写
入PLC。
触摸[PLC -> SRAM]将读取GP中 的
PLC数据(SRAM)。
触摸[↑] 和[↓] 按键可以滚动。

显示写入PLC的数据。

在读取PLC时写入从条形码阅读器获得的
字符串数据。
※ 必须使用条形码阅读器。

配方数据画面数据

2 3

4

5

13

2

1

5

4
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本节说明将GP中已经记录的
配方数据写入PLC的方法。

6.1
配方设置



实践操作教材

148

配方操作

・配方功能用于将GP中记录的配方数据写入PLC。
配方数据可以手动或自动传输(写入)。我们现在将了解如何手动传输它。
※ 配方数据 (文件0 写入连续PLC地址的数据组)。

・配方功能图示

LS区

SRAM

设置
A

设置
B

设置
C

･･･

D100 60 10 90 ･･･

D101 70 10 100 ･･･

D102 80 90 30 ･･･

D103 50 10 50 ･･･

配方数据

①标准传输(配方数据 -> SRAM): 在将FEPRPM或CF卡中保存的配方数据写入

PLC前必须首先将其写入SRAM。

②将数据从SRAM传输到CF卡: 在传输GP数据时，存储在SRAM中的数据保存

在CF卡中。

③ 通过LS进行设置: 配方数据可以保存到LS区，编辑然后传输到PLC。使用

配方数据显示中的开关可以对其进行[LS->PLC]和[PLC->LS]的传输。

④ 传输配方数据: 将配方数据传输给控制器。有两种方法，分别是设置控制传输

按钮从画面传输（手动）和通过在控制器侧设置控制字地址进行传输(自动)。

CF 卡

① ① ②

③

④

④

FLASHEPROM
(内存) 

D100
D101
D102
D103

示例：从D100写出四个字配方
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从工程管理器中执行[Filing Operation Setting]。

从工程管理器创建[Filing List]。

配方文件设置

传输画面数据至GP。

打开画面编辑器并将配方显示项目放置到基本画面上。

※仅在自动传输时才放置配方数据显示和每种开关类型。自动传输时无需创
建画面。

※Creates the recipe 

①使用“读取指示”键将配方数据写入
SRAM。(标准传输) 
②使用配方数据显示选择要传输的文件。
③如果您触摸了[SRAM->PLC]键。
④数据将会被写入连续的PLC地址。

①

②

③

④

标准传输 (SRAM <->PLC)
＝指定字控制地址和写入全部位地

址以从PLC读取SRAM中的配方输入。

※设置仅用于自动传输。

标准传输 (Filing Data -> SRAM) 
＝ 设置控制地址和全部位地址以

发送FEPROM或CF卡中的配方数据
至SRAM。

3

2

1

4
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配方数据设置

要将配方数据传输到PLC，首先必须将CF卡中或FPEROM中存储的数据保存到
GP的SRAM中(执行标准传输)。
这里将说明标准传输的设置。

从菜单栏中选择[Screen/Setup] -> 
[Filing Setting] -> [Filing Setting]。

(1) 选择配方设置

(2) 配方设置的内容

Filing ON/ OFF: 选择使用配方功能。
Use Multiple Folders: 选择记录多个文件夹

中的文件。

・标准传输 (Filing Data -> SRAM) 

Control Word Address: 设置字地址以用

于设置触发或将配方数据写入SRAM中的模式。

Write Completed Bit Address: 设置将配方

数据写入SRAM时需要[ON]的位地址。

・传输设置 (SRAM <->PLC)

PLC Controlled Transfer: 选择使用PLC传输 (自动传输)。

Control Word Address: 设置字地址以用于设置触发或将配方数据写入PLC中的模式。

Transmit Completed Bit Address: 设置将配方数据写入PLC时要置[ON]的位地址。

1

1

2

3

3

2

1

1
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・设置[标准传输(配方数据 -> SRAM)]中的[控制字地址]
【没有使用多个文件夹时】

【使用了多个文件夹时】※使用两个字

・设置[标准传输(SRAM <->PLC)]中的[Control Word Address]
※ 使用三个字

OFF OFF

017891015

写模式
触发

触发： 定时将配方数据写入SRAM
[ON: 写入] [OFF: 无写入] 

模式: 指定保存待传输的配方数据的位置。

第9位 第8位 写模式

OFF OFF 内存
(FEPROM)

OFF ON CF卡

触发器模式

文件夹编号

＋0

＋1

触发模式: 与[没有多个文件夹]中的内容相同。

文件夹编号: 设置存储待写入文件的文件夹编号。

＋0

＋1

触发模式

文件编号

块编号
＋2

OFF OFF

017891015

写模式 触发器

触发器: 定时将配方数据写入PLC。

[ON: 写入] [OFF: 无写入] 

模式: 设置配方数据的传输方法。

文件编号: 设置待传输的配方数据的
文件编号。

块编号: 设置待传输的配方数据的块

编号。

第9位 第8位 写模式

OFF OFF SRAM → PLC

OFF ON PLC → SRAM

要点



实践操作教材

152

配方数据列表

・配方数据列表说明了配方数据的存储位置、配方数据和详细的设置。

从菜单栏中选择[Screen/Setup]-> 
[Filing Data] -> [Filing Data List]。

(1) 选择配方数据

设置保存配方数据的位置。

(2) 设置配方数据列表
(没有使用多个文件夹时) 

记录的文件就以列表形式显示。

Add: 为要记录的文件添加设置。

Edit: 更改文件设置。

Copy: 复制已记录文件的设置。

Paste: 粘贴复制的文件设置。

Delete: 删除已记录文件的设置。

1

1

2

3

3

2

1

1
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以列表形式显示出[Internal Memory]和
[CF Card]中记录的文件夹。

(3) 设置配方数据列表
(使用多个文件夹时) 

在每个文件夹中保存的所有文件都以列表
显示。

设置已记录配方数据的文件编号。最多可
以记录2048个文件。

(4) 设置配方数据

设置数据传输的开始地址。

为每个块输入设置值

Add: 为要记录的文件添加设置。
Edit: 更改文件设置。
Copy: 复制已记录的文件设置。
Paste: 粘贴已复制的文件设置。
Delete: 删除已记录的文件设置。

No. of Data Blocks: 指定一个文件中要
设置的 数据块的数量。最多可以设置1650个
项目。(最大数量根据数据记录的情况而变化)
No. of Data Items: 指定一个块中设置项目
的数量。最多可以设置9889个项目。

Data Format: 选择16位数据或32位数据。
Display Format: 选择配方数据显示格式为［Dec］,［Hex］或［BCD］
Code+/-: 选择启用显示负值。

Import: 从其它文件(CSV格式) 获得数据。
Export: 以CSV格式保存配方数据。
Option: 设置项目传输名称和块编号。

1 2 3

1 2 3

4

5

6

3

2

1

3

2

1

6

5

4



实践操作教材

154

配方数据显示

・从GP画面将配方数据传输到PLC时需要使用配方数据显示。这里将说明对

配方数据显示的设置。

从菜单栏选择[Parts] -> [Filing Data Display]。

或单击配方数据显示(Filing Data Display)图标。

(1) 选择配方数据显示

(2) 设置信息

设置是否使用LS区。

设置LS区的开始地址，系统使用存储开始字地址并在那里临时存储数据。

可以使用LS区显示/编辑数据。

设置当配方数据全部传输给PLC时[ON]的位地址。
完成位地址不会变成[OFF]状态。

ID No.: 设置关系的标识号，它说明文件

显示与特殊开关之间的关系。请确保没有

副本存在，以防出现两个以上的配方显示。

File No.: 设置显示项目名称的文件编号。

・ 部件工具栏

・菜单栏

1

1 2

3

3

2

1

1
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(3) 显示设置

选择三种边框显示格式之一。

(4) 样式/颜色设置

选择显示颜色/清除颜色。

选择与配方数据显示配合的特殊开关。

(5) 开关设置的内容

选择自动放置的特殊开关的类型和颜色。

(6) 开关类型/颜色设置

No. of Display Lines: 设置显示的行数。

最多可以设置50行。

No. of Display Characters: 设置可在一行显示

的字符数。 最多可以设置100个字符。

Direct Selection: 允许直接触摸和选择所有

显示的项目。
Cursor Position Control: 允许控制光标

位置，即使画面 被转换也是如此。

光标在复位GP时会返回第一行。

1

1 2

1

1

1

2

1

1

1
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［设置流程]
1. 设置配方操作。
2. 记录配方数据列表中的配方。
3. 打开基本画面[B60]。
4. 设置/放置配方显示项目。

说明创建输入配方画面的方法。

在菜单栏的[Screen/Settings] 
[Filing Data]     [Filing Settings]。

选择[Filing (ON/OFF)]。

将[Control Word Address]设置为[D130],而
[Write Complete Bit Address]设置为[M225]。

清除[PLC Controlled Transfer]框并单击[OK]。

如何创建输入配方画面

1

1

2

3

(1) 选择配方数据设置

(2) 设定配方数据

3

2

1

1
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选择[Screen/Setup] -> [Filing Data] -> 
[Filing List]。

选择[Internal Memory] -> [0_Transport Line] 

选择[Edit]。

将[Data Storage Start Address]
设置为[D120]。

1

1 2

1

(3) 如何打开配方数据列表

(4) 如何编辑配方数据

(5) 现在设置数据存储的开始地址

1

2

1

1
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① 按以下显示设置块0。

Block Name Product A-1
D120 6
D121 100
D122 340
D123   61101

单击[OK]。

从部件工具栏选择[File Display Item]或
单击此图标。

在[ID No.]和[File No.]中设置[0]。

在配方显示项目中设置显示文件的编号。

1

2

1

1

(6) 如何输入配方数据

(7) 如何选择配方显示项目

(8) 现在设置此信息

1

2

1

1

要点
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・[Direct Selection]: 允许通过直接触摸选择项目名称列。

・[Cursor Position Control]: 光标位置保持不变，即使画面发生转换

也是如此。

设置[No. of Display Lines]为[4]，[No. of
DisplayCharacters]为[12]，并且按照您的需
要设置[Direct Selection]和[Cursor Position 
Control]。

根据的您需要设置[Border Type]和
[Display color]。

开关已经放置在学习材料中的画面数据，
首先要清除开关选择。完成设置后单击
[Place]。

1

1

1

(9) 如何设置显示格式

(10) 如何设置样式/颜色

(11) 现在我们设置开关

1

1

1

提示



实践操作教材

160

配方操作开关也会同时配合配方显示项目放置。这时对完成的项目进行分
组.要单独进行编辑，请单击右键并取消组。

另外，可以使用[Special Switch]为配方操作添加开关。这时，配方数据显
示与要添加的开关[ID. No.]必须相对应。可以在一个画面上设置多个配方显
示项目，并且对开关与操作的配方也根据[ID. No.]进行判定。

在红色边框中更改待输入的配方显示
项目并将其放置。

ID.NO
1

ID.ND
2

ID.ND
1

ID.ND
2

示例: 

初次组合 二次组合

1

可以单独编辑

(12) 如何放置配方显示项目

1

要点
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所连接的条形码阅读器仅限于本公司推荐的产品。请参阅[用户手册]以了

解推荐产品。

打开 [Project Manager] 并单击[Change the 
Extend SIO type for this project]。

在[Extend SIO Type]中设置[Serial BCR 
(K -tag)]。

[设置流程] 
1. 如何选择扩展串口设置
2. 更改扩展串口设置
3. 打开基本画面[B60]
4. 设置/放置设置显示部件

说明从条形码阅读器中
输入数据的方法

如何通过条形码阅读器输入数据

1

1

(1) 如何选择扩展串口设置

(2) 现在更改扩展串口的设置

1

1

要点
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单击 [GP Setup]图标。

单击[Extended Settings]中的[Extend SIO Settings]。
这时会显示[Extend SIO Communication Settings]。
这里可以置串口的通讯设置。它必须与条形码阅读
器相连的通讯设置相匹配。

※请参见条形码阅读器的手册以获得条形码阅读器
的通讯设置。

从部件工具栏中单击键盘输入显示(Keypad Input Display)图标。

1

1

1

(3) 如何选择扩展串口的通讯设置

(4) 如何设置扩展串口的通讯设置

(5) 如何选择设置显示

1

1

1
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将[Word Address]设置为[D125]，将[Start   
Input]设置为[Bit]，并将[Trigger Bit Address] 
设置为[M230]。

选择 [Char. String]。

将[No. of Display Char.]设置为[13]，而
[Character Size]则设置为[1×1(f)]。

单击[Browser]并按照您的需要选择图形。
同样，您也可以按照需要设置[Text Color]
和[Plate Color ]

1

1

2

1

(6) 如何设定一般设置

(7) 如何设定显示设置

(8)如何设置外形/ 颜色

1

1

1

2
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※完成放置后，可以更改大小以在显示器中存储13 个字符。

在[Input Style]中设置[Auto Clear ON]并选择

[Bar Code Input]。

在完成设置后单击[Place]，并将其放置到
[Product Code]的右侧。

可以通过传输画面数据获得来自条形码阅读器的数据。

不但可以获得一维条形码，而且还可以获得二维条形码。
请参见Tag参考手册以获得更多信息。

1

1

(9) 如何设置信息

(10)如何设定设置显示

1

1
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第七章 D-脚本编程

• D-脚本编程

• 密码画面制作
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本节对D-脚本编程作详细介绍

7.1

D-脚本编程
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D-Script (D-脚本)仅仅针对当前画面有效
Global D-Script(全局D-脚本)对所有画面均有效，适用于GP77和GP2000系列

添加一个D-脚本

删除选中的D-脚本

编辑选中的D-脚本

复制选中的D-脚本

粘贴D-脚本

关闭列表

帮助

D-脚本编号

D-脚本注释

(1)选择Special(特殊)下拉菜单

(2)选择D-Script (D-脚本) 弹出 D-Script List (D-脚本列表)

要点
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File (文件)下拉菜单

Export Text File (导出文本文件)：将脚本编辑栏里的内容转化为txt文本文

件后保存到指定目录。

Import Text File (导入文本文件)： 将指定目录中的txt文本文件内容在脚

本编辑栏里打开。

1

2

3

(3) Add(添加)按扭，编辑增加一条D-Script (D-脚本对话框)

3

2

1
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Use Syntax Guide (语法向导):可以抽取公式编辑栏中的数据。

触发栏用于设置启动程序的触发条件，当触发条件成立，便执行公式编辑
栏中的程序。
触发条件有三种形式:定时周期触发、位边沿触发和表达式条件触发。

1
2

Use Syntax Guide (语法检查):自动检查公式编辑栏中的语句是否合法。

(5) Trigger(触发栏)

1

选择定时周期触发时，设置触发时间(秒)，则每隔这一段时间，程序执行一次

定时周期触发

(4) Options(设选项)下拉菜单

1

1

2
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在设定位地址的上升沿触发。

在设定位地址的下降沿触发。

在设定位地址的上升沿和下降沿均触发。

1 2 3

位边沿触发

表达式触发

1
2

当Action(动作)栏中的表达式为由假(0)变真(1)时，程序执行一次。

当Action(动作)栏中的表达式为由真(1)变假(0)时，程序执行一次。

2

1

1

3

2
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当Show Toolbox被选中时，弹出右图所示D-Script Toolbox，在此工具箱中包含
了D-脚本所用到的所有指令

Bit Address：设置位地址。
Constant： 设置常量，有Dec(十进制)、Oct(八进制)。
Hex(十六进制) 三种数据格式。
Temp. Address：设置临时地址。
Word Address： 字地址。

Dataset(数据设置)

(A) Functions(功能)下拉列表框

在Functions下拉菜单中有五大部分:Data Set(数据设置)、Draw(绘画)、
Memory Ops.(内存操作)、SIO Port Ops .(SIO端口操作)、Bit Ops.(位操作)。

(6) D-Script Toolbox (D-脚本工具箱)
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Draw(绘图)

Call Screen：调用一个画面，需要设置画面号以及目标画面

中心所放置的坐标。
Circle：绘制圆需要设置圆中心坐标以及半径。
Dot： 绘制点,需要设置点放置的坐标。
Line： 绘制线段，需要设置线段放置的起始以及终结坐标。
Rectangle：绘制矩形，需要设置矩形的左上角和右下角坐标。

Memory OPs.(内存操作)

Memory Copy(内存复制)：该功能可以将字地址区段复制。
格式：memcpy ([w：DI Word Address]，
[w：SI Word Address]，Copy Size)

DI Word Address：内存复制的目标起始字地址。
SI Word Address：内存复制的源起始字地址。
Copy Size：设置区段(范围在1 ~ 640之内)。

范例1:

提示
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范例2:

Copy (variable)：间接可更改的内存复制。格式:_memcpy_EX(Parameter1，
Parameter2，Parameter3)

Parameter1：带偏移量的目标起始字地址，偏移量在临时字地址中设置。
Parameter2：带偏移量的源起始字地址，偏移量在临时字地址中设置。
Parameter3：设置区段，可以直接用常数给定，也可以用LS字地址或者临

时字地址设置(范围在1 ~ 640之内)。

Memory Set(内存设定):可以将字地址区间赋值

Set Word Address：设置起始字地址。
Set Data：给字地址赋值。
Set Size：设置区段(范围在1 ~ 640之内) 

提示



实践操作教材

174

该语句将字地址LS0020 – LS0024赋常量8。

范例3:

Memory Set (Variable)：间接可更改的字地址区间赋值(仅使用于GP2000
系列，GP2301和GP2501除外)。

该语句执行下列功能:将常量50赋于字地址D0108-D0112。

Offset Address:字地址偏移，该功能适用于GP77R系列、377系列和
GP2000系列

范例4:

格式：[Word Address] # [Temporary Work]，
该语句表示一个新的字地址，即旧地址
Word Address + Temporary Work的
数值而生成的新地址。

Parameter1：目标起始字地址，在临时字地址中设定偏移量。
Parameter2：赋值。可以在LS区或者临时字地址设置，或者直接输入常量设置。
Parameter3：设置区段，可以在LS区或者临时字地址设置，或者直接输入常量
设置 (范围在1 ~ 640之内)。

提示
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该语句表示:将字地址LS0205的内容赋给字地址LS0200 

SIO Port OPS.（扩展串口，适用GP2000系列)

范例5:

Label Setting

该功能可写，用于清空输出、清空输入、复位错误状态。
格式：以“位”为对象时:[c: EXT SIO CTRL**] ， **代表00 ~ 15 ，
以“字”为对象时:[c: EXT SIO CTRL]。

提示
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EXT SIO CTRL(扩展串口清空控制)

注意：当EXT SIO CTRL被设定后，程序将以如下顺序执行：复位错误->
清空输入->清空输出。

EXT SIO STAT(扩展串口状态)

注意:保留位留待以后设定，勿占用。

数据传输错误有两种：传输间歇和数据堵塞。当两种错误同时存在的时候，传输
错误位ON。数据接受错误有四种:奇偶错误、满载错误、帧错误、溢出错误。只
要其中之一发生，数据接收错误位ON。

只读
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EXT SIO RECV(扩展串口输入)

该功能只读，显示接收到的字节数

格式：[r: EXT_SIO_RECV]STR ERRSTAT］(字符串错误状态)

SIO Receive(扩展口数据接收)

从扩展串口读入数据写入指定地址寄存器

格式：IO_READ( [p: SIO Port No.]，[w: Receive Buffer 
Top Address]，10)
SIO Port No.(扩展串口)：指定接收数据的扩展口。.Receive
Buffer TOP Address(数据接收始地址)：起始地址存储接收

数据的数量，其后连续地址存放数据。
Receive Size(数据大小)：设定接收数据的数量。

范例:

该程序执行

提示
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SIO Send(扩展口数据发送)

从指定寄存器写入数据到扩展串口，然
后由扩展串口发送

格 式：
IO_WRITE ([p: SIO Port No.]，[w: Send Buffer  

Top  Address]，Send Size)
SIO Port No. (扩展串口)：指定发送数据的扩展串口。
Send Buffer Top Address(数据发送始地址)：指定发

送数据的起始源地址。
Send Size(数据大小)：指定发送数据的数量。

该程序执行：

范例:

提示
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Bit Ops.(位操作)

Clear Bit ：将指定的位置“0”。
Set Bit ：将指定的位置“1”。
Toggle Bit：将指定的位反转，0->1或者1->0。

(B) Statements(编程语句)

当( )中的条件为真，则执行{ }中的命令。

当( )中的条件为真，则执行命令1，否则执行命令2。
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循环执行{ }中的命令，循环次数设定于临时地址中。

在执行完命令1之后，不执行命令2，结束循环。Break指令适用于GP77R、
GP377和GP2000系列。

(B) Operators(运算操作符)
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左移位。将左边的数据向左移位，移的位数由右边的数据决定

右移位。将左边的数据向右移位，移的位数由右边的数据决定。

位的与运算。将两个字的对应位进行“与”运算。

范例

W0020 

t0000 

W0020

提示
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位的或运算。将两个字的对应位进行“或”运算。

范例

W0020

运 算 后

t0000

W0020

字取非。将一个字的所有位进行“非”运算。

范例

W0020

W0020

提示

提示
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(C) Compare(比较命令)

(D) 功能块

在写D-脚本的时候，可以将一些常用的功能写成一个函数，以便在其他
D-脚本中调用(GP270不支持该功能)。

Call:     调用一个函数。
New: 新建一个函数。
Edit: 编辑选中的函数。
Delete: 删除选中的函数。
Copy: 复制选中的函数。
Paste: 粘贴选中的函数。

如何编辑函数，请参照D-脚本编辑器。
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本章对用D-脚本进行密码画面

制作做详细介绍

7.2
密码画面制作
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密码在实际应用中是很有用的，许多地方需要进行密码保护，这样

可防止重要的操作参数被修改。下面主要介绍密码画面制作过程：

密码画面的作用

・密码画面制作的效果

说明密码画面的制作方法

如何进行密码画面制作

[设置流程]
1.打开基本画面B70
2.显示窗口。在窗口上放置一个K-tag。
3.本例中K-tag的地址设置如下图，字地址

设为：数据输入到D02000,触发位地址
设为M000308。

信息显示（Message
Display ),字地址：
D:00200

U-tag 字地址：D:02201

键盘每个数字键上放透明
的字开关.字地址:D:00200
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本例为四位密码。“Message Display(信息显示)”的
字地址设为：D00200。用D00200对键盘按键的次数
进行统计。按一下键时D00200=1，就显示一个*号；按
两下键时D00200=2，就显示两个**号，依此类推。
Message Display的设定如图所示，图中NO.of message
(信息数)选择8以上都可以。message所对应的每一条
信息在selected message中输入，0对应的信息输入空
白内容，l/2/3/4分别对应输入“*”、“**”、“***”、“****”。

・密码画面制作方法

先建一基本画面，为了要输入密码，就要有一个键盘输入显示窗口。
在窗口上放置一个K-tag(如图)就可以实现。本例中K-tag的地址
设置如下图．字地址设为：数据输入到D02000，触发位地址设为：
M000308。

当然要输入密码就要有个键盘，可以在部件中直接选择，形状可以根据
需要改动。
在实际输入密码时我们当然不想让别人知道，在输入密码时用*号来表示，
这个功能可 以用部件中的“Message Display(信息显示)”来实现。

提示

2

1

3
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下面实现用D00200对按键次数的计数。

D ENT键上的透明开关是为了实现输入密码后判断密码是否正
确。ENT键上透明位开关设置，位地址M000303。

A  为配合*号显示，在键盘上叠加放置透明的开关按钮，对按键

次数的计数。

B 数字键上透明的字开关，按下时“次数加1”，设置如下，
字地址是D00200（同Message display相对应），按下时内
容加1（如果1个*号按一下就2个*号）。

C CLR键上透明字开关，按下时“次数清零”，设置如图 ：

4
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A 先在另外的一个基本画面里制作报警内容。
B  将它注册为一个报警窗口如右图。
C 在密码输入画面，使用U-tag。U-tag的

字地址：D0201；放在画面5上自己认为
可以的地方。

当输入错误的密码时需要弹出一个报警对话框，提示密码错误。这可以用
U-tag实现。
(U-tag的使用在上一章中也有介绍)。

相关的D-脚本

D-脚本编程是此例中最主要的，可以在基本画面B70上，菜单栏选择
Special的下拉菜单D-脚本，再选择Add，就可以进行编程了。
本例包括进入画面时初始化、密码判断、关闭报警窗口几个脚本

进入画面时初始化

图中当画面跳到基本画面B70 (LS0000是系统区地址，它的内容显示的是当前画
面号，本例是B70画面) 时，信息显示(D0200)为零，报警信息 (D0201  U-tag) 不
触发，键盘输入显示 (D2000) 为空，set[(M0308)]使键盘输入处于待输入状态 。

6

5
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本例固定密码为：9999
if ([w:D2000]==9999)//假如输入等于“9999”

{
[w:LS0008]=10//画面跳转至B10
[w:D2201]=0//不调用报警画面
[w:D2000]=0//K-tag显示为“0”

[w:D0200]=0
}

endif
if ([w:D2000]<>9999)//假如输入不为“9999”

{[w:D2201]=1//弹出报警画面
[w:D2000]=0
[w:D0200]=0

}
endif

*图中Edge Bit Address(沿触发地址)为：LS010001，同ENTER键上的透明
的位开关相对应，当ENTER键按下后就执行这个脚本进行判断。

密码判断
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提示

关闭报警窗口、清除信息、重新开始输入至此，密码画面
制作功能完成 。

① 本例中固定密码为9999。如果要想在实用中采用可变密

码，则用数据寄存器代替，寄存器的值就是密码。这样修改密
码只需要修改寄存器的值。
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第八章 扩展串口应用

• 扩展串口的应用
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本节对用扩展脚本编程做简单介绍

8.1
扩展串口的应用
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这个功能仅适用于GP2000系列
扩展串口通过D-脚本的编写能够方便的实现通讯。

下面的命令用于读从扩展串口接收到的数据。
格式
IO_READ([p:EXT_SIO]，LS Storage Address，Transer Byte)
例如
IO_READ([p:EXT_SIO]，[w:LS0100]，10)
[p:EXT_SIO]表示接收数据
[w:LS0100]这是存放接收数据的起始地址，接收数据的大小存放在LS0100，
接收的数据从LS0101开始存，10表示有10个字节存放在LS区(最大传送字节
是6095) 

下面的命令表示把要发送的数据写到扩展口
格式： IO_WRITE([p:EXT_SIO]，LS Storage Address，

Transer Byte)
例子： IO_WRITE([p:EXT_SIO]，[w:LS0010]，10)
[w:LS0100]是要发送的数据的开始地址，
10表示要发送10个数据，
*注意：传送的数据是字节，也就是说传送的是每一个
字的低八位，同样接收的数据也是一样的。

・扩展串口的应用范围和作用

・扩展串口的功能

(1) 接收功能

(2) 发送功能

备注：GP2×01系列需要切换SIO后才可使用．该功能在C-Package02 v6.30
以上才支持



实践操作教材

194

LS0100 00 Byte1

LS0101 00 Byte2

LS0102 00 Byte3

LS0103 00 Byte4

LS0104 00 Byte5

LS0105 00 Byte6

LS0106 00 Byte7

LS0107 00 Byte8

LS0108 00 Byte9

LS0109 00 Byte10
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增加控制变量去清除发送和接收缓存器以
及错误状态，这个变量的属性是只写的。

格式
位： [c:EXT_SIO_CTRL**]  **:00 to 15
字： [c:EXT_SIO_CTRL]
例如：控制字的内容

(3) 控制

位：[c:EXT_SIO_CTRL00] = 1
字： [c:EXT_SIO_CTRL] = 0x0007

位 内容

15 保留

14 保留

13 保留

12 保留

11 保留

10 保留

9 保留

8 保留

7 保留

6 保留

5 保留

4 保留

3 保留

2 1：清除错误状态

1 1：清除接收缓存

0 1：清除发送缓存

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

当控制字的内容被确定以后，它
的处理过程按照这样的次序来完
成的，先清除错误状态，然后清
除接收缓存，再清除发送缓存。
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增加 [EXT_SIO_STAT] 作为状态变量，

这个变量的属性是只读的。
格式：
位 :  [s:EXT_SIO_STAT**]**:00 to 15
字 : [s:EXT_SIO_STAT]

例如
位 : if([s:EXT_SIO_STAT00]=1)
字 : if(([s:EXT_SIO_STAT]&0x0000)<>0)

字的内容描述如右图.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

(4) 状态

位 内容

15 0:没有扩展串口协议
1:有扩展串口协议

14 保留

13 保留

12 保留

11 保留

10 保留

9 保留

8 保留

7 保留

6 保留

5 保留

4 保留

3 0:正常 1:接受错误

2 0:没有接受到数据
1:接受到数据

1 0:正常 1:发送错误

0 0:发送缓存有数据
1:发送缓存没有数据

A、只检测有效位，保留的位留作以后用。
B、当数据传送发生错误时，数据传送错误

的位便置1。
C、当数据接受错误发生时，数据接收错误

位便置1。

提示
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这个属性也是只读的。格式 [r:EXT_SIO_RCV]
例如 if([r:EXT_SIO_RCV] >= 10)

这个设置可以在离线方式(OFFLINE)或者在GP system中进行

设置 设置范围 设置值

传送波特率

2400,4800,9600,
19200,38400(bps)

9600bps

数据长度

7,8(bits) 8(bits)

停止位

1,2(bits) 1(bits)

校验位

None,Odd,Even None

(5) 接收数据的大小

(6) 扩展通讯口的设置
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现在有一个通讯仪表，它有一个RS485口，它支持多种波特率。

(1) 参数设置

首先在GP的扩展串口设置中选择和仪表的通讯设置一样的参数。(一个起始
位，8位数据，无校验位，一个或两个停止位)

(2) 新建工程

新建一个工程，PLC类型选择Memory Link SIO type，协议选择
General SIO protocol。

(3) 画面编辑

在主画面上建立如下几个部件:
1） 位开关 它的地址是[b:005200]，相对应的标签是初始化，功能

是”momentary’’。
2)  位开关它的地址是[b:203802]，相对应的标签是自动收发功能是“bit Set”。

再可以放若干个用于输入要发送的数据“数据输入”部件和相对应的要显示接
收数据用的“数据显示”部件，这样就可以很清楚的看到通讯是否成功了。

(4) D-脚本编写程序

触发条件是「b:005200]的上升沿
if([S:EXT_SIO_ STAT15]==1)  //判断端口的状态，检查是否有扩展串口协议
{[w:通讯步骤]=1
[w:超时设定]=3  //3秒的超时(这里的数据可以改变)
[w:下一通讯]=1
[c:EXT_SIO_CTRL]= 0x07  //将发送缓存和接收缓存区都清0
}
endif

第一个程序
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第二个程序

第三个程序

第二个程序是主程序，触发条件是
「b:203802]上升沿

if(1)
{  if([b:通讯允许]==1)  //允许通讯
{    if([w:下一通讯]==1)  //有多个通

讯命令时，用此控制
{  if([w:通讯步骤]==1)  //第1步发送

{if([S:EXT_SIO_STAT00]==l)  
//发送缓冲为空

{IO_WRITE([p:EXT_SIO]，
[w:0080]，8)  //发送数据

[w:通讯步骤]=2  //发送完

成标志
[w:接收超时]=[w:超时设定]  

//接收超时
}

endif
}
endif //结束通讯第一步
if([w:通讯步骤]==2)  //第2步接

收数据
{if([S:EXT_SIO_STAT02]==1)  
//接收缓冲区有数据

{if([r:EXT_SIO_RCV]>=10)  
//接收10个数据

{10_READ([p:EXT_SIO]，
[w:0100]，10)

[w:通讯步骤]=10  //完
成读数据

[w:下一通讯]=1  //多个

通讯命令，改此值
「b:通讯允许]=0

}
endif

}
endif

if([w:接收超时]==0)  //发生超时
{[w:通讯步骤]=11

[w:下一通讯]=1  //重复发送该命令
「b:通讯允许]=0

}
endif

}
endif //结束通讯第二步

}
endif

}
endif

}

第三个程序:它用于检测通讯是

否超时，
触发条件是每隔一秒运行一次

if(「w:接收超时]>0)
{[w:接收超时]=[w:接收超时]-1
}
endif
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